Fast Track to Trouble Shooting
Part II
By Team Digit

With valuable inputs from our Digit Forum Community - thinkdigit.com/forum
Credits

The People Behind This Book

EDITORIAL
Robert Sovereign-Smith Assistant Editor
Rossi Fernandes Writer
Nash David Copy Editor

With special thanks to the thinkdigit.com/forum members for their contribution to the Digit community

DESIGN AND LAYOUT
Vijay Padaya, U Ravindranadhan Layout Designers
Rohit Chandwaskar Cover Design
Harsho Mohan Chattoraj Illustrator

© 9.9 Interactive Pvt. Ltd.
Published by 9.9 Interactive
No part of this book may be reproduced, stored in a retrieval system or transmitted in any form or by any means without the prior written permission of the publisher.

July 2008
Free with Digit. Not to be sold separately. If you have paid separately for this book, please e-mail the editor at editor@thinkdigit.com along with details of location of purchase, for appropriate action.
Trouble In Paradise?

All of us, whether *Digit* readers, or *Digit* writers, love our PCs. We care for them, upgrade them and guard them ferociously with anti-virus and anti-malware apps. However, as hard as we try to keep them healthy and happy, every now and then they’ll catch a cold, cough, sputter and die—for no apparent reason at that. One minute you’re happily computing and the next you see errors, BSODs and hear terrible beeping noises. Due to popular demand, we decided to publish a second *Fast Track to Troubleshooting*, in the hope that we can play a small part in keeping your PC healthy and happy.

In this book you will find a collection of the most common niggles that you face on a day-to-day basis, with solutions provided. You will also find some rare problems, some buying/upgrading advice and even some preventive tips to keep you from having to troubleshoot in the first place.

We would also like to give credit to our thriving 41,000+ member *Digit Forum* ([www.thinkdigit.com/forum](http://www.thinkdigit.com/forum)) community for helping fellow members out of a jam, and providing solutions to those in need.

When we found that a particular problem was asked and solved on the Forum, we’ve included the answers from forum members as the solution. If you see a *Note:* below the answers, that’s additional information added by us when we felt it was needed.

This book has also been broadly categorised to help you find solutions when you need them—Hardware, Windows, Linux, Applications and Miscellaneous.

We strongly urge you to read this book, even if you don’t have any troubleshooting to do right away, because not only will it prepare you for those times when you need to solve problems, but will arm you with the knowledge you need to help your friends when they need assistance. Here’s looking forward to you becoming a troubleshooting guru in your circle, and also celebrating the first of many *Colour Fast Tracks* to come.

Write in to us with suggestions for topics you want to read about, at editor@thinkdigit.com.
Chapter I
Hardware

Often, the problems we face are caused by hardware. From PCs that refuse to boot to weird BIOS errors, and faulty drivers to dead hard drives, you're bound to have one of these problems at some point or another. Unlike software, hardware needs your full attention to detail to resolve conflicts and errors. Here is a collection of some popular and some weird hardware questions we've received

Page 7

Chapter II
Windows XP

With the majority of the world using Windows as their OS, it’s no surprise that most problems people have are Windows-related. Here we’ll show you solutions to some of the most common Windows troubles

Page 40
Chapter III

**Linux**

Whether you’re a newbie or a seasoned Linux professional, the very nature of Linux distros is to allow you to tweak to your heart’s content. Alas, things often go horribly wrong with such tweaking. In this chapter, we aim to provide Linux newbies with answers to common questions.

Page 60

Chapter IV

**Applications**

We now move on to troubleshooting the software applications that are most commonly used. When they do occur, some of these problems may end in hairloss or wrinkled foreheads. We’ve compiled these from the Digit Forum.

Page 84

Chapter V

**Miscellaneous**

Here you’ll find problems that are so weird that they don’t qualify for any of the previous sections. The fact that we’ve received these questions, however, means that people out there are facing such problems. Solutions ahead.

Page 117
More often than not, the problems we face are caused by hardware. From PCs that refuse to boot to weird BIOS errors, and faulty drivers to dead hard drives, you're bound to have one of these problems at some point or the other. Unlike software, where an uninstall-and-reinstall is a good solution, hardware needs your full attention to detail to resolve conflicts and errors. Here is a collection of some popular and some weird hardware questions we've received.
Problem With Writer

I have a desktop with a Gigabyte 939 (GA-K8N51GMF-9) motherboard, an AMD 3500+, 1 GB of DDR1 dual-channel PC400 RAM, a SATA 160 GB HDD and a Sony DVD writer running Windows XP. The problem is that whenever I write on a blank DVD, although it seems to write, I cannot access the written data later from Windows Explorer. Plus, the drive shows up as a CD-ROM drive. I even re-installed Windows XP, but the problem continues. I even installed my friend’s CD-writer on to my system, and it works fine.

Secondly, my DVD writer plays only a few DVDs well—for example, Digit DVDs or DVDs that I wrote a month ago. My writer is just five months old, and I have seldom written CDs or DVDs. My writer used to format written CDs and DVDs as CDFS or UDF. However, lately it’s been writing in RAW format. I use Nero to write my disks, and sometimes, I use ULead Movie Factory. The DVDs written in RAW run on my DVD player, though.

Mandeep Singh Sandhu

It appears the problem lies in your DVD writer. Now that you have tried your friend’s writer on your system, you should take your DVD drive to your friend’s place to see if it works there. Your drive isn’t very old, so it should still be within warranty. Data DVDs are usually burnt in the ISO format.

bios problem

I have an original Intel 915GV motherboard (bought in August 2005). I want to update my BIOS, but the problem is that the Intel site returns about 4-5 (915 motherboard) similar options (I also don’t have an Internet connection, but can easily download it on to a CD / DVD at a cafe). Another problem is that SiSandra Lite XII tells me that “the BIOS surface mounted on an unsuccessful flash may be fatal”. Also, is DDR2 memory compatible with it (even without a BIOS update)? If yes, then up to what frequency, given that the computer vendors in Indore tell me it isn’t compatible. Please give me a detailed explanation.

Rohit Tambe
Do not bother updating your BIOS, if you don’t have a problem with your system. Any locking up during the flashing procedure will result in a board that won’t work anymore. If you have to update it, then get the exact model number for your motherboard. Be sure that you are flashing the board with the correct BIOS for your exact motherboard. Look for the motherboard packaging if you still have it. You can also find information when the computer boots. SiSoft Sandra can also help you find the exact model number. The 915GV chipset supports both DDR and DDR2. DDR 400 and DDR2 533 are supported, but you cannot use both at the same time.

PC Configuration

I’m planning to buy a new PC. It would basically be a gaming rig (FPS and racing games). Can you please suggest a configuration for this PC? My budget is Rs 50,000-51,000. I would prefer it to be future-proof for at least three to four years.

Would there be any significant performance gain (better gameplay) in case of increasing the RAM from the current standard of 2 to 4 GB or 8 GB? If so, what do you recommend?

Is there any need for having a separate sound card, or is the on-board sound solution good enough for hi-fidelity sound experience in gaming and music?

Siddharth Bhatnagar, Mumbai

A budget of Rs 50,000 should just about get you an Intel Core 2 Duo E8400, a P35-based motherboard from Abit, 4 GB DDR2 RAM, a 640 GB Western Digital hard drive, a 22-inch LCD screen from Dell and a GeForce 9600GT or a 8800GT.

Calling it future proof for three to four years might not be the right thing to say. Games and hardware evolve so quickly that you might find at least the graphics card getting outdated in just around two years from now.

An onboard sound solution will do just fine for all the regular games. But if you plan on buying headphones worth more than Rs 4,000 or speakers over Rs 10,000 or more, then a dedicated sound card is a must.
**Motherboard And Graphic Card**

**Q** My first problem—I have a Lenovo Y500 notebook with face recognition feature. Most of the latest games requiring NVIDIA graphic cards are not supported by it. Is it possible to change its configuration? If not, then here is my second question. I have a 4-year-old Compaq Presario PC, and its motherboard doesn’t have the required slots for a graphic card. Please tell me a suitable motherboard and graphic card that can play games like *Matrix*, *Lord of the Rings*, *Half-Life* and other latest games. My budget for now is Rs 8,000. Please help me, so that I can return to my world of gaming again.

**Akash Sharma**

**A** Laptops allow upgrading certain components like memory and hard drives. A graphics solution is not possible on your laptop. If you wish to play lots of games, then a complete overhaul is required. If your Compaq Presario has an AGP slot, then you could look for an AGP GeForce 7600GT. A motherboard change today would mean you have to go for a new processor and DDR2 667 memory as well, and then a new graphics card would be unavoidable.

**Problem Playing High Resolution Videos**

**Q** My computer has Intel Original 845GVSR motherboard, Pentium 4 2.4 GHz Processor, 256 MB RAM, 80 GB HDD. I don’t have an AGP slot. I’m using Windows XP 32-bit. Recently, I formatted my system due to some viruses and made a new copy of XP. The problem is that when I try to play XVID or AVI, having resolution above 1000x650 (below 1000x650 resolution works well), the system suddenly crashes showing a black screen. I’m unable to operate anything. The system still runs in the background. I have updated all my motherboard drivers, and also installed some codecs. These haven’t worked either.

**A** A GeForce 7600GT AGP card will be a cheap yet a fairly powerful upgrade. Trying using third party applications like Media Player Classic and VLC Player for HD playback.
been of any use. Before formatting, these videos played well on my system. So what’s the problem in playing high resolution video files? I don’t want to spend on any upgrade on my system. Please help me. Thank you.

Charan Reddy

Try installing Media Player Classic or VLC Media Player ([www.videolan.org](http://www.videolan.org)). Your system might not be able to handle HD resolutions very well. Try installing ffdshow from [http://ffdshow-try-out.sourceforge.net](http://ffdshow-try-out.sourceforge.net). If you are running H.264 content, then CoreAVC is well known for being an optimised decoder. It is commercial software, but a trial version and more information on it is available at [www.coreavc.com](http://www.coreavc.com).

Help... Cannot Boot!

I have a desktop with Intel Core 2 Duo 2 GHz, Intel Original G965 board, 1 GB RAM, 160 GB HDD, with Windows XP SP2.

My problem is that whenever I start my PC with any external device attached to the USB ports (like pen drive, Bluetooth dongle or a card reader), it boots up nicely into XP, but as soon as I use my keyboard, it hangs and I have to reboot the system once again. After the reboot, everything works fine.

This is getting very frustrating. I reinstalled Windows XP, but the problem is still there. Can you please suggest a way to solve my problem?

Syed Zubair, Bangalore

Make sure you have all the USB devices disconnected when you boot your computer. Check if the computer hangs even when they are disconnected. Install the latest drivers for the motherboard, and also try changing the PnP OS support option in the BIOS.

Mac Book Or Laptop

I’m about to venture into the mass media realm, and had picked out a very nice offering from the Dell XPS range for myself, for just under a lakh. Since I would be working with a lot of graphic intensive applications from Adobe, my friend suggested that I go in for a Mac Book. Now I don’t know what to do. Please help me. My budget is a lakh, and I have a requirement of at least a 15.4-inch screen with an adequate graphics card to run...
some heavy rendering applications. I’m a complete newbie to OSX.

Rudresh Jariwala

A MacBook Pro is what your friend is talking about. The Dell XPS will probably give you more power than an entry level MacBook Pro. The MacBook Pro will also attract a lot more attention among your friends than a Dell XPS. If you want the ultimate performance for the work you do, then a proper performance desktop is highly recommended.

Connect TV To PC

I have an Intel Pentium 4 HT, with an Intel D101GGC motherboard, NVIDIA’s 6200 LE (256 MB) graphics card. How can I connect my PC with my 21-inch Sony WEGA (HW21-M80) TV?

I want to do so to watch movies! Please help!

Avik Sarkar

A Your graphics card may come with a TV-out feature, which should allow you to connect to your TV. Most cards come with an S-Video out but you may need to purchase a converter for S-Video to RCA or component.

PCI Problem!

I have an IBM PC with 768 MB of RAM with processor speed of 2.60 GHz Intel 865G chipset with 64 MB of onboard graphics. I recently bought a GeForce 8400GS of 256 MB graphic card. But it didn’t fit into my PCI slot. What’s the problem? Please help me out and if possible, also, suggest a compatible graphics card for my PC.

Samonjoy Bhattacharya

A We aren’t sure of what interface the card you just bought is. Your Intel 865G based motherboard only supports AGP cards. From the
sound of it, it seems you have bought a PCI-Express card, which is a completely different standard, and it will not fit into your motherboard. You need to buy an AGP card. Look for a cheap GeForce 7600GT or maybe an ATI Radeon x1800 card.

**Problem**

My desktop configuration is as follows:

- Intel 915 chipset, Gigabyte motherboard, 512 MB RAM DDR, 80 GB Hard disk, DVD writer, and my board supports up to 4 GB.

  I recently bought Transcend (184p DDR DIMM 128 M*64) 1 GB RAM (64M*8 DDR400 3-3-3), and have installed it. I tried booting, but after power ON, I see nothing on the monitor, except hearing a ticking sound from the CPU. My old 512 RAM is Dynet DDR400(3) 512M*8

  **Salman Binali, Palakkad, Kerala**

There are chances of compatibility issues between different RAM sticks and that could be the problem. Unplug the older Dynet RAM and try to boot with only the new Transcend memory in place to see if it works. If it does, you’re going to have to get another 1 GB RAM stick to run in dual-channel mode.

**HDD Not Detected**

I have 200 GB IDE Seagate HDD. I was using it on my computer, but then removed it. Now I’m trying to use it as an external HDD with a 2.0 external HDD case. It’s showing in the device manager, but, it’s not listed in My Computer.

  I’ve also tried to connect it directly to the CPU as an internal HDD, but the same issue continues. Please suggest, as I have some critical data in it. I use Windows XP. And I have tried it in two different computers with NTFS partition.

  **Tirtha Basu**
At first, it seems like your drive may have failed. Start the Computer management application from Start > Control Panel > Administrative Tools. Go down to Disk Management and look for your drive there. If there is no drive, then your drive may in fact be damaged. If the drive shows up, but no partitions are visible, then you may have lost data and the partition information. You should try using some data recovery software if you need to recover the data and then re-partition your drive.

**Help For AGP Graphics Card ATI Radeon HD 2600**

I wanted to buy an AGP-based graphics card for my PC. Intel 865GBF motherboard, Pentium 4 (2.4 GHz), 1 GB RAM. I think ATI Radeon HD 2600 XT is a good card. Is it better than HD 2600 PRO, x1800, x1900 modes (which you mentioned in April 2008)? What are the prices of these graphics cards? From where can I buy this graphics card?

Sameer Mahant

The ATI Radeon HD 2600XT is a superior card to the 2600 PRO, but the x1900 is a faster card than the 2600XT. The only drawback of the x1900 is that it is a hotter and a non-DirectX 10 card like the 2600XT.

**CPU Auto Shutdown?**

I have a Pentium 4 assembled PC with D101GGC motherboard, 256 MB of RAM, and an 80-GB HDD.

The problem is that when the computer is running fine, there is a sudden tripping sound that my APC ES 500 UPS makes, and the monitor screen goes blank, leaving the keyboard and mouse lights ON. Then to turn on the CPU again, I have to turn off the UPS and then turn it ON again. When turned ON, the CPU automatically powers ON, without any need to press the power button. Is the power fluctuation a problem, or the SMPS? Can you help me please?

And another small question... Can I install a Vista version on this motherboard, if I upgrade to 1 GB RAM. Also, mention the version which will work the best in 1 GB RAM.

Sagar Gholap
It is likely that your UPS has a problem and you should try running your computer directly on the mains to see if it works flawlessly. 1 GB of memory is a bare minimum for Vista to run. 2 GB is highly recommended for Vista, so add in more RAM.

Graphics Card

I recently purchased an NVIDIA XFX 8600GT graphics card (512 MB DDR2). Due to my busy schedule, I could not do much research before buying. Later on, I came to know that 256 MB graphics card with DDR3 is much better instead of 512 MB with DDR2.

One of my friends wants to purchase a graphics card very soon. Which one should I suggest?

My PC configuration is as follows: Intel D101GC motherboard, 1.5 GB Memory, 17-inch TFT Samsung monitor, Pentium 4, 2.66 GHz.

I'm very much satisfied with the performance of my PC and graphics card, but I still want to know what exactly is the difference, when buying a 512 MB graphics card with DDR2 over 256 MB graphics card with DDR3. Please reply as soon as possible.

Wamiq Maqbool

512 MB or 1 GB of graphics card memory does not do a lot for a low- or mid-ranged graphics card. The big difference in these memory standards is the bandwidth they offer, but that alone shouldn’t be a deciding factor for purchasing a graphics card. DDR3 RAM on graphics cards is preferred, though on your PC, the graphics card is already the fastest component. Unless you upgrade to a better CPU and motherboard, you need not worry about DDR2. For those running 3D applications (3ds Max/Blender), more RAM is preferred.

Upgrade Issues

I’m using an LG MyPC, which has an Intel Pentium 4 processor, 2.0 GHz, Intel 845G motherboard, 248 MB of RAM, 40 GB hard disk and Windows XP SP2 running on it. I want to know if there is any good NVIDIA graphics card for my motherboard. Also, if I want to upgrade my PC with an NVIDIA motherboard and graphic card to play the latest games, how much will it cost? My budget is around Rs 10,000 to 12,000. Help me please.

Ankit Sinha
For playing games that have been coming out in the past year or two, you should really consider a completely new system. Your two big upgrades—keeping the rest of the system the same—are the memory and graphics card. Add at least a GB of RAM and upgrade to a decent AGP card, like a GeForce 7600GT or an ATI Radeon x1800 or x1900 series. We’d still recommend a complete system overhaul though.

**Motherboard For PC Config**

**Q** I want to upgrade my system with the following configuration:

Intel Core 2 Quad Q6600 Processor, 2 GB DDR2 RAM Transcend. I’m currently having 250 GB HDD + 17-inch monitor. I just want to know, which motherboard is best suited for my configuration, as I don’t want to go for graphics card right now. I selected the Intel G33 TL chipset, but according to online surveys, it doesn’t perform too well. So please suggest a motherboard, with an on-board graphics solution, that’s suitable enough to run Vista Ultimate without problems. I do not want a gaming rig. Also, suggest a motherboard that will be available in India over the next month. My overall budget is Rs 20,000 (including Processor + RAM)

_Aashish Jindal_

**A** Your processor and memory is more than sufficient to run Windows Vista. The G33 might not have the best onboard graphics solution, but adding a dedicated graphics card will increase the performance phenomenally. You could also add another 2 GB of memory. If you spend a lot of time gaming, then a GeForce 9600 GSO, 9600 GT or an 8800 GT would be great cards to buy. They are priced between Rs 7,000 to Rs 12,000. If you just want something that is Vista-compatible, then a GeForce 8400 GS or an ATI Radeon 2400 XT will do. Unfortunately, we cannot recommend that you use onboard graphics with a Q6600 and 2/4 GB of RAM for Vista Ultimate—that’s just criminal!

**USB Problem**

**Q** I have a problem regarding the USB slot of my PC, which I think you guys will surely sort out.

Actually, the problem is, when I connect any pen drive to any USB port,
either my system hangs or the CPU usage shoots up to 100 per cent (without indicating any device connected). At times, I thought it could be a virus present in those devices, but those same devices work absolutely fine on other systems. But, when I connect some other devices such as my mobile or my MP3, the device gets detected and runs fine. I have already formatted and reformatted my system several times and reinstalled the drivers, but the problem persists.

So, I request you guys to please help me out of this situation. Just because of this problem, I still have to rely upon my CD writer to carry data as I am not able to buy a pen drive for myself. Please help. My motherboard is Gigabyte 845i and I use a Pentium 4 2.4 GHz processor.

Piyush Gurung, Dehradun, Uttarakhand

Be sure to install the latest drivers from the Internet for your motherboard. An antivirus on Windows could also be locking up the USB drive trying to scan it. If you can get your hands on a Linux LiveCD, boot into it and try connecting your flash drive. See if the drive is accessible. Try attaching the drive to some of the other USB ports or detach all USB devices and use the flash drive.

**Harddisk Problem**

My problem is that my hard disk (WD-250GB) is detected as a removable drive. Please help. My Configuration is AMD (Athlon) 5200+ Processor and ASUS VM Board 1GB RAM.

Avin Tokade

The detachable drive is to do with NVIDIA drivers and Windows XP. Try installing the latest motherboard drivers. There is a quick fix if the problem isn’t solved. Start your registry editor by clicking on **Start > Run > regedit.** Browse to **HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\**

A small registry change can get rid of the removable disk icon for your internal drive.
Create a new DWORD called DisableRemovable and enter the value as 1. Restart Windows to have the changes come into effect.

Faulty DVD Drive????

I have a HL-DT-ST RW/DVD GCC-4522B from LG DVD ROM. The problem is that it can read the DVD from Digit and other original DVDs, but it can’t read burnt DVD from Moser Baer (Rs 20 ones). I have burned DVDs on my friend’s computer.

Cool Fellow

Many a times, DVD drives do not support all kinds of media from the different manufacturers. One of the ways to fix this problem is to flash the firmware of the drive. Look on the manufacturer’s site for your model and check if there is any firmware release to improve media reading capabilities. Also, there could be something wrong with your friend’s DVD writer. Check the DVDs burnt on his PC on a third PC, to make sure the DVDs haven’t become coasters.

SLI

I recently came to know that an SLI motherboard supports more than one graphic card. Can you tell me how to connect the VGA cable, since both the graphic card has VGA outlet.

Ashish Mathew

An SLI motherboard is meant to connect two identical NVIDIA cards together to get better performance out of them. Usually, any one of the cards can be used to connect to the display, but you also need to use a bridge between the two cards inside your case.

High FPS On Slow system, Low FPS On High System

I have a laptop. Its configuration is Intel Celeron M Processor 1.40 GHz, 256 MB DDR SD RAM, 64 MB integrated video memory (Mobile Intel 915GM) and I also have desktop PC configuration—Intel Pentium 4 processor 2.6 GHz, 256 MB DDR SD RAM, 64 MB integrated video memory (Intel 82845G Extreme Graphics). When I installed GTA San Andreas on my laptop, it runs very fine on low settings. But when I run them on my desktop, the frame rates are very low on low settings. What can I do to play GTASA on my desk-
top PC with good frames? I’ve updated my video drivers, defragged my HDD, and stopped unnecessary running programs from Task Manager, and even stopped the anti-virus!

Puranjai Mall

The 915GM motherboard is a newer and a better graphics solution than the one on your desktop. 256 MB is too little to run Windows XP and GTA: San Andreas on. Adding a dedicated 6600GT or 7600GT can improve performance but you also should add more memory—at least 1 GB of it.

PC Woes

I’m sending this mail about my PC problem. When I start my PC, it shows the following message:

CMOS checksum error-
defaults loaded

Warning! CPU has been changed, Please enter CPU speed, CMOS setup and save before exit.

It asks me to press [F1] to continue. Please give me some suggestions about this problem.

Anish Panicker

Enter the BIOS and reset the settings to default. Save and reboot and look if the problem continues. If it does, the battery on the motherboard may have become old and needs to be replaced.

Question

1. In my computer, folder option is there, but I cannot find the option to show hidden files. How can I repair without formatting the disc?
2. My motherboard is ASUS P5W DH Deluxe 975 chipset, its tempera-
ture rises up to 55 degrees. Processor is Intel Core2 Duo 2 GHz. CPU temperature is 16 to 21 degrees. What can be the possible reason for the motherboard overheating?

RS Khiangte, Aizawl

The temperature of 16 to 21 degrees Celcius is very strange. You should carefully reach in and touch the heatsink of the processor to see if it really is that cold. Most Core 2 Duos running on the stock heatsink run between 35 and 50 degrees Celcius on idle depending on ambient temperatures. 55 degrees Celcius is high but you shouldn’t be too worried. It is only when any of your components go over 65 and 70 degrees Celcius that you need to be concerned.

From The ThinkDigit Forum (thinkdigit.com/forum)

Moody Resolutions

Q I am using an LG Flatron L1752S (17-inch LCD) monitor with my PC (845GVSR 2.4 GHz motherboard with a Pentium 4 processor). Recently, I am suffering from display resolution problems. I used to set my resolution to 1024x768. But when I restart my PC, then the resolution automatically changes to 1280x1024.

So, I want to know whether there is any way to fix the resolution problem. If yes, please help.

flatron

A 17-inch non-widescreens have a native resolution of 1280x1024. This is also a non-widescreen. Hence, it is recommended that you use 1280x1024.

iMav

LCD should be used at native resolutions. For 17-inch monitors, it is 1280x768. Stick to this resolution. Reinstall VGA card and monitor’s drivers.

Desiibond
How To Check RAM Frequency?

I have a Compaq Presario SR5250IL PC, with 512 MB of DDR2 RAM, which is a real bottle neck for now. I wanted to upgrade my system. Can anyone tell me how to check the RAM frequency? I am planning to get a 2 GB kit and planning to use it along the 512 MB. Is this a good way to go?

DigitDonz

Install cpu-z (http://www.cpuid.com/cpuz.php) and you can see all technical info of your PC hardware including RAM frequency.

sanyaldk

Will 1 GB RAM work fine with 512MB?

I'm planning to increase my system RAM and planning to buy 1 GB RAM for my PC. Someone told me that I can't use both RAMs together. Please tell me if this is true. My system configuration is:

Windows XP SP2, Intel Pentium 4 Processor, D865GSA Intel motherboard, 512MB RAM, 80 GB Seagate HDD, Sony DVD-RW

Ashok Verma

If frequencies of RAM match, use the two capacities together.

xbonez

Yes. It will work. Just make sure it has the same frequency and timing. Much better if it comes from the same manufacturer.

desiibond

Anisotropic filtering in games?

What is bilinear, trilinear and anisotropic filtering in games? Which option must be used for best graphics and which must be used for fastest performance? Do they need any special hardware like GFX cards?

Prakash Gourav
Anisotropic filtering will give you better looks, but performance maybe hit. You need a graphics card that supports anisotropic filtering.

Bluetooth!

I’m using my cell phone’s Bluetooth to connect to the Internet. Is it true that using Bluetooth a lot damages it? Internet is on at least 12 hours a day, via GPRS through Bluetooth. So is it okay to do so? Will it not be damaging to the Bluetooth device?

I don’t know about the Bluetooth system, but it will surely shorten your battery’s overall life.

Your overall battery life may go down. Instead of giving, say, 10 hours on 100 per cent life, it may go down to 7 or 6.

Please Help. “usbenchi.sys” Missing

When I connect my iPod (30 GB) to my computer (XP), the “DO NOT DISCONNECT” screen on the iPod does not appear. Also in XP, only the message “A high speed USB connected in a non-hi speed USB port”.

When I went to device manager, I saw a yellow question mark on the USB mass storage icon. When I tried to install the driver, it asks for “usbenchi.sys”. Can you guys tell me from where I can get the usbenchi.sys file?

You do not have USB 2.0 drivers installed, or the port you are connecting the iPod to is a USB 1.1 port.

Check if you have a USB 2.0 port on your computer and if you have drivers installed.

Note: You can search Google to find the file that you need, just make sure it’s from a legitimate source.
PC Woes

A friend of mine is facing a slight problem. I’d be grateful if you can help in diagnosing what the problem is. The problem is that every morning after he starts the computer, it restarts on its own every 5-10 minutes, for 5 to 6 times at least. It has got worse for the last 6 months. The SMPS has been changed and the engineer now says it’s a cooling problem.

The PC configuration is Pentium 4, 2.4 GHz, 512 MB RAM (256x2), 80 GB HDD. It is 3 years and 3 months old.

Thanks for all the help.

godsownman

As an initial step towards nailing down the issue, I recommend you to install this “Intel active monitor” software or any other software that monitors the temperature of the processor to check, if it is in fact, due to heating. If so, then, you might have to apply a fresh layer of thermal paste between the heat sink and the processor.

legolas

Please Help Me... Strange Problem

Whenever I put any CD or DVD in my CD drive, then my computer drastically slows down while copying files to my hard drive. I have a good configuration, which can run such programmes easily. Is it due to a virus?

saubrl

Check if DMA is enabled for both your optical drive and hard drive.

abh1shek

Note: To do this, open device manager (Start > Run > devmgmt.msc), find IDE ATA/ATAPI Controllers and double-click on each channel shown. Under Advanced Settings, if you see any channel set to run in PIO mode, change it to DMA if Available.
Compaq Beeping Sound

I have a Compaq desktop. Whenever I play any game, a beeping sound starts up after about 5 to 6 minutes. Why does this happen? How do I stop the sound?

The beeping sound could be from the motherboard’s alarm due to rising temperatures. Go to the BIOS and look at the temperature of your processor. If it is overheating, then you should attend to it. If the alarm temperature is set to really low, then set the alarm temperature to around 70. The beeping could also be from other applications running in the background.

Can I play 720p And 1080p On My PC?

My system configuration is
- Intel Core2 Duo E4500 @ 2.2 GHz
- Kingston 2 GB DDR2 @ 667 MHz
- NVIDIA 6200 LE, XFX 8800 GT Alpha Dog Edition
- Seagate 320 GB SATA, 160 GB WD Cavair

Running HD media should not be an issue on your system. A dual core processor itself should be just about sufficient to run the videos.

Problem With ATP3

My ATP3 was running OK till yesterday. But today when I powered on the speakers, and played a movie, the woofer was full of distortion, although the satellites sound perfect. Then I brought the bass level to zero, but still sound from the woofer is like a wet tabla. I felt the bass had gone, only the vibration is there. I am very upset.

I purchased the Altec Lansing ATP3 2 months ago. At the time of purchase, the production of ATP3 had stopped. So I searched every shop and managed to get one. I had never imagined such sound quality, and was extremely happy. I am a bass freak, so I started playing at full bass. Then after some days, I kept the bass at 50 per cent and continued to listen at this setting. I may have done a wrong thing at first when I played some of the
sound testing files like ‘ultimate woofer test’, ‘deepest bass test’, etc. After these, I felt the bass is distorting at high volumes, which it was not when I first purchased the speakers. But I managed the problem as I don’t listen at high volumes.

But the current problem was unbearable for me. I have tested everything but no result. The woofer was unable to produce even slightest bass. Only if I lower the volume level to 10 to 20 per cent, does the distortion reduce.

Please advice.

Gurujee

A Sorry to hear about your problem. The ATP-3 is really nice for the price. There are a few possibilities.

1. The woofer may have been damaged from the excessive bass drives you subjected it to. The cone suspension may be torn, or the coil suspension may be displaced. In such cases, replacement or repair of the woofer is the solution. Problem is, a matching woofer is probably difficult or impossible to get, and repair can be done only by someone who’s experienced in doing the precision work necessary.

2. The screws attaching the woofer inside the cabinet may have been loosened by vibration.

3. The screws attaching the cover of the cabinet may have been loosened by vibration, or the connector jack may be loose.

I have seen all of these problems happen with computer speakers.

pimpom

Changing A Laptop Graphics Card

Q I was thinking about ordering an XPS 1530 from Dell, but was thinking whether it will be possible for me to change the graphics card later? I know the RAM can be easily changed. But I’m not sure about graphics card. Also, can I find a laptop graphics card in the market? Thanks.

aytus on Digit Forum

A It’s not possible to change the graphics card. So go for a good one like 8600MGT. Also retail laptop graphics cards are not easily available here.

Hrithan2020
Monitor System Temperature And Fan Speed?

Q Which software can I use to monitor parameters such as temperature, fan speed, etc?

ramsingh

A Use coretemp to monitor temps and speedfan to monitor fan speed. Speedfan also tells you the temperature, but it’s inaccurate at times.

amitash

Audiophiliac woes..

Q I currently own a Sony PSP for games and music, but the sound quality is disappointing. Can you suggest a good cheap PMP with excellent sound quality? I don’t need a screen or it to look cool or with excessive storage (1-4 GB should be enough). I just need EXCELLENT SOUND QUALITY! Please recommend something less than Rs 5,000, because I blew all my money on the PSP. Also recommend a pair of good earphones with I repeat, EXCELLENT SOUND QUALITY. I need good bass, good highs and lows, good everything. I have a budget of around Rs 1,500 for the earphones. I looked at the Creative EP 550 or 600 something and they were good, but not too great. Can you recommend something better? I listen to a lot of hip-hop / rock. Thanks

threeonethree

Transcend T-Sonic 630 and Creative EP630.

Cool G5
**Overclocking Failed. Please Help!**

Configuration: Quad Core Q6600
- ASUS P5K-VM MOTHERBOARD
- 320 GB WDC HDD
- 2 GB ZION SINGLE RAM
- 500 W SMPS

Problem: My system suddenly restarts and displays
Overclocking Failed! Please Enter Setup to re-configure your system
Press F1 to Run setup
Press F2 to Default Values and Continue.
I don’t know what to do. When I Press F1, it goes to BIOS. Then I don’t
know what to do.
Please help.
Any one knows how to overclock?

*jerin3013 on Digit Forum*

Just press **[F2]** to load default values (as you have said earlier, you
don’t know what to do in SETUP).

*ashu888ashu888*

*Note: If you don’t understand the BIOS settings, why are you trying to over-
clock? Overclocking voids your warranty, and can damage your hardware, so
attempt such things at your own risk.*

**Monitor Problem**

I have a Compaq Presario PC of model no. SR1105IL.

I’m facing a problem with my monitor, that is, the colour adjusting
bar appears automatically and fluctuates in itself, disturbing me and while
I’m trying to close, it reappears again.

Kindly send me a solution for this and also clarify whether it’s a virus or
a spyware or any problem related to hardware.

*Subhransu Kumar Nayak*

If you are talking about the colour bars on your display interface,
then it may be appearing on the screen as your monitor is really
old and the buttons could be damaged.
Creative Elite Pro Sound Card

Q I have an ASUS P5B-VM motherboard, XFX 7900GS Graphics Card, 2 GB RAM, C2D 6400 Processor system and Logitech Z5500 digital speaker system. I am planning to buy Creative Elite Pro sound card. The requirement of the card is: Available PCI 2.1 slot for the audio card. What is this PCI 2.1 slot? Is it a normal PCI slot? So will the sound card be compatible with my motherboard?

Temperworld

A Yes, it’s the normal PCI slot.

infra_red_dude

Noisy Speaker

Q I have a pair of Creative SBS245 speakers. When I start my computer, everything works fine, but after half an hour, disturbing chirping noise comes from the speakers every time I click on anything. The noise comes even the media files can be played due to this disturbing noise.

I have onboard SoundMax audio with latest driver available on Intel’s site. I have even tried to lower the hardware acceleration level to 0. Nothing works. Kindly help me out. I have an Intel 865GBF motherboard, 1 GB RAM, 80 GB hard disk, 2.4 GHz processor.

Fighter from Digit Forum

A Double-click on the volume control icon in system tray. Click on Options > Properties. Select line-in and mic. Mute them.

iMav

Laptop LCD Questions

Q I have an Acer laptop. I generally listen to music during the night. However, I always have to keep the LCD screen open while listening to music, to prevent it from going to standby mode instantly. I also download
torrents throughout the night during the free hours. For this also, I have to keep the LCD open. Is there any way or option by which your laptop won’t enter the standby mode with the LCD closed?

gurujee

Assuming you use Windows,

1. Go to Control Panel > Power options
2. Check “Do nothing when I close the lid” in the option or in the Advanced tab.

Now your PC will stay ON with the lid closed.

drgrudge

SMPS Query

Today I purchased the following:

Intel DG33FB motherboard LGA775, C2D 2.66 2x1 GB RAM, Sony 20x DVD writer, XFX 512 MB 8600GT, Zebronics chassis. I asked the dealer to give me a 500-W SMPS, but he insisted on 400 W (comes with Zebronics chassis). Will this be sufficient for the above configuration?

techn_lover

450 W should be enough. But I’m not sure if you can do some over clocking or over volting. You will be better off with a 500 W from Zebronics. I have the same (Rs 1,400) in Bangalore.

Chichi

How To Make Anologue Videos Digital?

I had found an old Sony handycam, which my dad bought around 1995. I had some priceless videos in it. So I wanted to ask you how I could convert them to digital.

Hullap from Digit Forum
Firstly, see if your computer has a graphics card (a simple TV Tuner / capture card will suffice). Secondly, see if the handycam has an S-Video port. If yes, then you need to buy an S-Video cable. Connect the cable to the graphics card slot.

Run Windows Movie Maker v2.0 and capture the video from the handycam. You should have sufficient space (20+ GB) in the HDD partition that you would store the captured file. Save the captured file (MPEG4 format) in the HDD. Run Nero and convert the captured file to VCD / SVCD format and write it on a blank CD.

Addendum: Prior to start capturing, you should connect an audio cable from handycam to the sound card of your computer to capture the audio.

avik_chat

Urgent: System Crash!

Q I am getting the following message when I switch ON my PC:
Reboot and select proper boot device or insert boot media in selected boot device. In addition, I’m unable to open C: from the recovery console.

I’m getting the following message: Fixboot cannot find system drive, or the drive specified is not valid.

Ron

A I think the HDD has gone kaput. First check whether the HDD is properly detected by the system BIOS. If it is, then it can be a case of partition loss only. Otherwise, you’re out of luck. Prepare to purchase a new one. If it’s partition loss, try various tools that are available both for free and paid ones. I once lost my partitions while installing Linux, I used the Ultimate Boot CD. It contains a utility called testtool, which is a text UI-based one, but works very nicely. And yes, do check the data and power cables of the HDD also.

Krazy_About_Technology
If you have XP, use the bootcfg command to fix your boot.ini entries. However, since you say, you couldn’t access C drive from the recovery console, I’m afraid there are issues with your hard disk.

**Mouse produces a jerky movement in game!**

Recently, I got myself a new assembled PC. My configuration is:

Intel Core 2 Quad Q6600 2.4 GHz
- MSI P7N SLI Platinum
- 2 GB Corsair RAM
- XFX GeForce 8800 GTS 640 MB DDR3
- 500 GB SATA hard drive
- Windows Vista Ultimate SP 1

I am an avid gamer, and with a configuration as mentioned above, I expect some decent gaming experience. However, ever since I got this PC, it behaves worse than a Pentium 3! For instance, it hangs unnecessarily even when I am surfing the Internet. However, coming to the major problem that I am facing, while playing this game “Kane and Lynch”, the mouse produces a jerky or slow movement when I move to look around. The same happens with “Spiderman 3”. At some point, it behaves normally, but then it also produces a jerky movement. I have all the latest drivers required to run these games, but the problem persists. I have been searching over the Internet for quite sometime now, but can’t come up with anything specific. Unfortunately, in all the forums that I went through, nobody it seems is aware of the exact reason behind this problem. They say that by lowering down the resolution in the game or turning off anti-aliasing will solve this issue, but unfortunately, that also didn’t help. My PC has all the latest Windows updates as well. Kindly help me, as I am still on my vacation and my itchy fingers are dying to ram the keyboard with lots of gaming around.

Varun Kumar Sah

Firstly, we hope you have all the drivers for your motherboard and graphics card installed. The locking up of the computer could be
because of high temperatures. You have not mentioned what power supply came with your system. We recommend a good power supply of at least 500 W for your configuration. You mouse may be the culprit as well—mice with low DPI might give you the impression of stuttering.

**Some Questions!**

I have some questions and I would be highly obliged, if I could get the answers.

1. My current configuration is Pentium dual core 3.0 GHz with 2 GB DDR2 RAM and GeForce 8600GT 256 MB. Transcend RAM, supported by a 965 motherboard. Is this configuration sufficient to run games like **DIRT**?

2. Would a Core 2 duo processor (the basic versions) outperform a dual core clocked at 3.0 GHz?

3. How much help would it be for gaming if I upgrade from 2 GB to 4 GB of RAM?

4. Instead of RAM if I go for a 8800GT card, would it be a much better option (my budget is limited)?

5. Would you recommend me upgrading XP to Vista for gaming?

---

**Raunaq Sahay**

Your system configuration should be able to run the game **Dirt** at medium settings at resolutions of 1024x768 just fine. A Core 2 Duo and a GeForce 9600GT or one of the newly released cards—Radeon 4850 priced at around $200 from ATI should do much more. A Core 2 Duo running at 3 GHz can help further improve the performance. The Core 2 Duo E8400 is one such processor that runs at 3.0 GHz. 2 GB of memory is decent amount of memory to run Vista and games. 4 GB of memory is just useful in making your system a little more future-proof. 4 GB of memory means you would also need to get a 64-bit OS to utilise the entire 4 GB. An 8800 GT is great value for money. With the release of new cards from NVIDIA and ATI, it is a good idea to wait a week or two till prices of the costlier 9800GTX or higher performing cards, drop to around that of 8800GT. An XP to Vista shift will not change your performance at all, so it is all up to you which OS you prefer to use.
One Long Beep, 2 Short Beeps

My old PC (bought it in 2006) configuration is as follows:
- AMD 64 3200+ 939
- ASUS A8N-SLI PE
- 7600GT
- 1 GB DDR400 Kingston
- Antec SP-400W

Today, suddenly while it was running, I heard one long beep and two short beeps continuously, with no display. Removing the graphics cards and reinserting it makes no difference, and I hear the same beeps. I even tried with a spare 6600GT. I still get the same beep codes. The 7600GT works fine in another PC.

I removed all the memory, but still get the same beep codes. Even tried with different combinations of memory and memory slots, to no avail. I removed the processor and re-installed it back, but still have the same problem.

Well, looks like it’s a motherboard problem.

There is some problem with the video interface on your motherboard. That’s what the long and two short beeps mean. And as you are sure that the card is ok, then surely the motherboard’s PCIE interface has some trouble.

Get it replaced if it’s still in warranty.

Turn Off Cordless Mice And Keyboard

I have purchased Cordless Logitech Ex 90 (Mouse and Keyboard), and installed two batteries in the mouse and also in the keyboard

I can’t turn off the mouse. I press the green button and remove the receiver from the USB port, but still there is light in the mouse. Any idea, why?

Also, any idea how many hours do the batteries work? If I use mouse for five hours daily, then when will be batteries get drained?
The green button at the bottom of the mouse indicates the mouse connection with the receiver. The only way to switch off the mouse is to manually remove the batteries. The batteries should last for about three months. Even I’ve used the Logitech EX-90, and at present, I’m using a Microsoft Wireless keyboard and mouse. I’ve even tried to remove the mouse battery to save battery power.

assassin

**Which router to go for—802.11n or 802.11g?**

Q I wanted to buy a Linksys wireless ADSL router. Which one should I buy? There are two technologies—802.11n and 802.11g. Can anyone explain what’s the difference between them. Which one to buy and which one would be expensive?

raja2281 from Digit Forum

A If you can afford, then get the 802.11n router. You’ll get a higher transfer rate and larger coverage area.

hellgate

**My HDD crashed!**

Q I have a problem with my PC. I wanted to repartition one of my drives (it was empty then) and so used Paragon Partition manager for the same. But during the process, a power shutdown occurred. After that, the partition I worked on and two other partitions next to it were corrupted. The other partition contains 30 GB of My Documents. I recovered the partition with Acronis Disk Director (PMagic does not even start, says there is a problem in the Partition table info) and the data using Stellar Phoenix Windows Data Recovery. But still some directories show up empty and not all files are recovered. The other two partitions do not even show up. They are discovered as RAW partitions. I know this is a long shot, but any suggestions as to what can be done?

Aparajith from Digit Forum

A You can also use this [http://hddguru.com/content/en/software/](http://hddguru.com/content/en/software/). Download partition find and mount software. This allows you to recover deleted partitions. What’s special in this program is that it allows you to mount lost partitions right into the system, so the OS sees that lost partition like a good one.
This software also has the possibility to create and mount images of the entire hard drive or separate partitions.

**Computer OFF, Power Light Blinking**

I have a desktop. Yesterday, I experienced a strange problem. My computer had been ON for about two hours. I was accessing the Internet, and Bitlord was running along with anti-virus and firewall. I left the computer running and took a break. I had turned OFF the monitor.

After about ten minutes, I noticed the computer had shut down. But it’s power light was blinking with an interval of about two to three seconds. Everything else connected to the computer was OFF. Even the SMPS was OFF and it’s fan wasn’t running. When I pressed the reset and power buttons, nothing happened. I tried moving the mouse and pressing the keyboard keys, but nothing happened. I eventually had to turn OFF the UPS to shut down everything. The Windows Event Viewer shows nothing related to this problem. I have checked the power settings and everything seems fine. This problem has occurred for the first time.

What could have happened?

---

**Overclocking The 8600GT**

I got an XFX8600GT 512 DDR2. I want to overclock it. I’m new to overclocking. stock- core clock-540. memory clock 400. When I change the clocks using ntune to anything above 620 / 450, the system crashes. Why is that? What else do I have to change in ntune? Never done this before. My CPU is Q6600 and motherboard is DG31PR. Why can’t I overclock it to about 700
/ 500 and keep it stable? It crashes if I increase it by 50 MHz.

kooki

Overclocking is not that difficult, but you got to be really careful and follow some basic rules.

1. Be careful—overclocking can burn out your card, and damage your hardware.
2. Tweak the setting a bit, and test it for 15 to 20 minutes.

Use ATI tools (works perfect with NVIDIA card) or RivaTuner. Tweak and Test, Tweak and Test.

asigh

Will My Graphics Card Support Widescreen Resolutions?

I have a doubt that if I buy this or any widescreen monitor, my configuration will not support the 1440x900 resolution that these widescreen TFTs offer.

How do I make sure that my Graphics card will support this resolution?

I have checked My Computer > Properties > Settings, but the maximum it shows is 1024x768 (Though I will recheck this). The documentation of DG965ry says that it supports 2048x1536. Is there any alternative way? What is the option, if it does not support? Also, I checked many local shops, and all 19-inch monitors have widescreen TFTs only.

ninadb

The GMA x3100 (on the 965 chipset) supports widescreen resolutions. Go ahead and buy yourself a new TFT.

infra_red_dude

Note: To check all resolutions, under My Computer > Properties > Settings, look for the Advanced button. Click this and under adapter you should find a choice to view all supported resolution by the camera.

Yellowish Display

Whatever image I see is yellowish, whether it is my desktop, during bootup process, etc. In short, why are the colours not appearing like they should.

I also connected another CPU on the same monitor, but it had the same
problem. Now I think the problem is in my monitor only. And my computer engineer said that the monitor needs repairing. Is there anything that I can do?

khansaqib101 from Digit Forum

A I guess the colour temperature of your monitor needs to be changed. It’s set to 6500K most probably. You need to set it at 9300K. To change the colour temperature, use the controls in front of your monitor.

narangz

A A faulty VGA cable can also give you such problems. If you have a cable that has been twisted for a long time, there is a chance of such colouration. Check the cable and then proceed to calling your manufacturer’s service personnel.

IDE Problem

Q I’m slightly confused. Will HDD and DVD ROM work in the same IDE cable? My friend has only one IDE port in his motherboard.

Dhanusaud from Digit Forum

A Yes it will work. Set the HDD to Primary Master and DVD ROM to primary slave or you can set the HDD to primary slave and primary DVD ROM to Master. It’s your choice.

shift

Components Needed For Vista

Q My system configuration is mentioned below:
System Manufacturer: Intel
System Model: D865GBF Model 2004
On-Board Video memory: 64 MB
System Type: x86-based PC
Processor: x86 Family 15 Model 2 Stepping 9
Genuine Intel 2,793 MHz
BIOS Version / Date: Intel Corporation BF86510A .86A.
SMBIOS Version: 2.3
Boot Device: PATA1 80 GB \Device\HarddiskVolume1
Total Physical Memory: Slot1 DDR1 256 MB

I know that Windows Vista will not run on my system, until I upgrade the system. If I will change only the below mentioned items in my system, will Vista run on it?

1. One DDR1 RAM of 256 MB, that is, upgrade from 256 MB to 512 MB.
2. One 256 MB graphics card, that is, upgrade from onboard, 64 MB to 64 + 245 = 317 MB.

One dealer told me that I have to change my D865GBF motherboard and Family 15 Model 2 processor to Vista compatible. I know that my board is not Vista compatible, but if I upgrade the RAM to 512 MB and VideoCard to 256 MB, will Vista run on my computer?

Also, what will be the LOWEST cost of the upgrade, that is, RAM and AGP VideoCard?

emailaatif786 from Digit Forum

Yes, Intel 865G and above chipsets are officially supported by Intel for Windows Vista. This means there are official and proper drivers for it. No need to upgrade the CPU and motherboard, just get 1 GB RAM and a GeForce 6200 graphics card with 128 MB RAM as minimum. If you have the budget, then go for AGP GeForce 7300GT with atleast 128 MB RAM. With 512 MB RAM and a graphics card, Vista will run fine but 1 GB is recommended these days anyway. 865GBF has four RAM slots, so you can increase RAM easily.

I’m right now using it on 865GBF motherboard with 1 GB RAM and GeForce FX 5900XT graphics card. The lowest configuration I have installed Vista Home Basic is Pentium 4 2.4 GHz with Intel 845GEBV2 motherboard with onboard graphics and 512 MB RAM. It runs fine with the default drivers in Windows Vista for the chipset, etc.

gx_saurav

Error!

Sometimes when I start my desktop, the boot process only shows Intel desktop motherboard’s screen. After sometime system says that boot device not found and prompts me to restart the system.

I heard a ‘beep’ tone whenever I got ‘boot device not found...’ error!

quad_master
I had the same problem in my computer (less the beep sound). The problem was with the loose connection in the power / data cable. Disconnect and reconnect the cables properly and see if it works.

PcEnthu
With the majority of the world using Windows as their OS, it’s no surprise that most problems people have are Windows-related. Here we’ll show you solutions to some of the most common Windows troubles.
Administrator Problem

Q I bought a second hand computer. It has an administrator account, due to which I can’t install any software or drivers. I see a message that says, “you must have administrative privilege to install this software” or “You can’t access this drive”

Please help me to make a new administrator account, so that I can install software. Else, help me to modify the existing account.

Harshit Gautam

A You should back up any data that you have on to flash drives or CDs or DVDs. Format your drive and reinstall Windows XP. If you want to avoid all this trouble, you can ask the previous owner for the administrator password. Only an administrator can create new users.

Icon Problem

Q I’m trying to change my HDD icon by placing a .ICO file and creating an autorun.inf file. However, after creating the autorun file, it disappears in a few seconds. There seems to be a problem in my PC. I tried this on my friend’s PC too.

Please help me out and suggest me some software for creating icons.

Anurag

A If you want to create a shortcut to your hard drive, simply create it by right clicking on the desktop. Click on New > Shortcut. Type C:\ if you want a shortcut to the C partition. Click Next,
and continue to create the shortcut. Right-click on the shortcut, and click on Properties. Click on the Shortcut tab, and then click the Change Icon button. Click Browse and point to the location of the icon. If you want more flexibility, change the icon of your hard drive and other components using a software called IconPackager (www.stardock.com/products/iconpackager/).

Start Up Error

Q I have a Compaq Presario V400 (Intel Celeron M 1.3 GHz, 512 MB RAM). It has Microsoft Windows XP Home Edition installed. There are two problems:

1. Windows gives an error at start up stating “Windows cannot find C:\windows\SVChost.exe Make sure you typed the name correctly, and then try again. To search for a file, click start and then click search”. Here, I see a second message stating “Could not load or run C:\windows\svchost.exe specified in the registry. Make sure the files exist on the computer or remove the reference to it in the registry.” I don’t know what is wrong and how to fix this. Please help.

2. When I connect my laptop to a power supply, it gives a mild shock at its metallic part. However, if I change the plug it doesn’t. Is this because of improper earthing in the sockets? If this is the case, then how do I find out if my power plug has proper earthing or not, and is suitable for the laptop to be connected? Please help.

Anshul Munot

A Your first problem is most definitely a virus or worm. You need to preferably install an antivirus or run an online virus scan to look clean the worm or virus. Your second problem is because of faulty wiring and you should try connecting the laptop and the same adapter in some other place to see if you have problems with it.

Stupid Hidden Folders

Q I have Pentium 4 2.26 GHz Processor on Intel original 845 motherboard with 256 MB RAM and using Dual Operating System as Windows 98 SE on C Drive and Windows XP Professional on D Drive. My
problem is that I have one hidden folder on my D drive (Windows XP installed) namely “System Volume Information\_restore” with many sub folders namely ‘Rp 107, Rp108 and so on up to Rp 137’. When I tried to scan one of these folders, namely Rp 126 with Norton Antivirus 2003, my system restarted by itself. Is something wrong with this folder? How are these folders created? Also, this folder ‘system volume information’ is quite huge (3.15 GB). Can I delete it? Please reply. Also, my D drive (with Windows XP installed) have some other hidden folders as ‘found.000, found.001, found.002, etc. up to found.011’ and one other namely ‘MSOCache’ with a size of 526 MB. How are these folders created? Can I delete them?

Manish Kumar Aggarwal

The System Volume Information folders contain all the system recovery data, which are used when your OS gets corrupted, or when you lose some data. If you want to save that space, you can disable system recovery by starting System Properties from Start > Control Panel. Click on the System Restore tab and then on Turn off System Restore on all drives. Some drives can be disabled individually by clicking on the drives listed below and then on the Settings button.
Task Manager Disabled

Hi, I have a laptop, but without an Internet connection. I visit Internet parlours occasionally to download photos, and at times, themes for my mobile. Last time my pen drive was infected with a virus. Whenever I create a folder, automatically another folder gets created by the same name inside my folder. It shows up as a Microsoft Windows Corporation folder in the subtitle of the folder. The same thing happened on my laptop also. After that, following things happened:

1. When I tried to access my C:\ drive, I couldn’t. It shows an hourglass and nothing happens.

2. When I press [Ctrl] + [Alt] + [Del], it says “taskbarmanager has been disabled by Administrator”. Since yesterday, my laptop is not booting up at all. It shows up a welcome screen and stops at that.

   I don’t know much about all these. Please help me out. I’ll be grateful.

   Sagar Reddy

Your pen drive is infected with some kind of worm or virus. The quickest way to fix this is to get a powerful antivirus such as Kaspersky or NOD32. Update the virus definitions and clean your system. Also, make sure to format the pen drive, so you don’t end up infecting any more systems, including your own when you are done. You should boot into safe mode to do the cleansing.

Boot Reboot

I have a serious problem with my PC. Whenever I try to boot my system, it work fine for a few minutes and then automatically restarts in a few minutes. I have installed SP2. Please help.

   Anurag Sen

The problem could be with anything. It could be a corrupted Windows installation if your XP doesn’t boot completely. If the computer boots normally and then randomly reboots, it could be a faulty power supply, or even a heating issue.

LAN Problem

I have two PCs running Windows XP SP2. I connected them with a PC-to-PC LAN cable and shared their hard disks (in both machines).
Everything seemed OK, and I disabled the firewall and antivirus to play games. To test, I pinged them and got a positive result, I can also play *FIFA 08* and can view the contents of machine 2 from machine 1, but when I want to see the contents of machine 1 from machine 2, it says //1 is not accessible, you might not have permissions to access this resource. Please contact your system administrator. I tried Microsoft Help and Support, but didn’t find any solution. What is the problem and what should I do? Please help.

**Anindya Biswas**

---

Right-click on the folders you have shared. Click on Properties, and then on the Security tab. Make sure the necessary permissions are allotted to the users. If that does not work, open the registry editor by clicking on Start > Run and entering `regedit` there. Browse to `HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Lsa` and change the value of the `restrictanonymous` DWORD to 0.

---

**A Crude Problem?**

I’m using Windows XP SP2. I inadvertently deleted the NTLDR file from my C:\ drive.

Now, whenever I try to restart my system, it says NTLDR is missing please restart. How can I solve this problem? It’s very crude. Please help.

**Anurag Sen**
NTLDR is the boot loader for your Windows XP. Fixing the problem is simple. Boot using the Windows XP installer CD and get into the Recovery console. Type `COPY D:\i386\NTLDR C:\` Where D:\ is your CD / DVD drive. Reboot the computer.

**Using Vista or XP on my laptop**

Q I am buying a new laptop, with Windows Vista as part of bundle, but I am thinking of downgrading to Windows XP, after experiencing the performance of Vista as it goes really slow. Shall I move down to XP or are there any ways to possibly to enhance the performance of Vista? If so, kindly provide me with a few. This will be helpful, as I don’t want to spend on XP unnecessarily.

A As long as you have 2 GB of RAM, Vista runs well. 1 GB is a bare minimum for it to run, but clearly you should have no problem. Using Vista or XP is a personal choice. If you have the option of choosing XP over Vista and saving money, then opt for XP, since you seem to prefer it. If you’re going to have to spend more to get XP, stick with Vista, it’s more secure.
Cute Problems

Q I use Windows XP SP2 on my system. I had installed Creator Pro version 2.0 (build# 31). I tried to make a setup with it. At 99.99 per cent, the setup creation process stopped and it displayed an error message. Can you please help me? When I tried to install Windows XP SP3 on my friend’s PC, it stops by displaying a message as shown in the attachmed picture. Can you please solve the problem? Also, in the March 2005 edition, you have given a way to integrate SP2 into Windows XP. Now can you please show me a way to integrate Windows Vista SP1 to Windows Vista? Thanks

Chikku George Thomas

A Most likely, the error is because the installer ends up being too big. If you are using FAT32 partitions, then you are bound to get this error. Use a NTFS partition and try again.

The reason your friend is unable to install Windows XP SP3 is because he has some kind of enhancement utilities installed for the login screen or for boot up screens. Uninstalling these applications and restoring the default Windows files will allow you to install SP3.

Vista integration can be done using software called vLite like nLite, which is very much like nLite.
HAL.DLL

When my PC boots up, an error message appears sometimes. The message is “Windows could not start because the following file is missing or corrupt: <Windows root>\system32\hal.dll. Please re-install a copy of the above file.” but when I again restart the problem doesn’t appear. My system configuration is Intel DG33FB motherboard, Core 2 Duo 2.66 GHz processor, 2 GB DDR2 RAM, XFX 8600 GT GEFORCE, 160 GB SATA hard disk, Creative sound blaster Audigi sound card. Please help me out.

Sayandeep De

Your hal.dll file has been corrupted or has got deleted. Boot using the Windows XP installer CD and get into the Recovery console. Type EXPAND D:\i386\hal.dll C:\WINDOWS\SYSTEM32\hal.dll (if D:\ is the CD/DVD drive). Reboot the computer.

Help

Can you please tell me how to implement the “shutdown” button on the desktop as an icon, instead of “Start” in the status bar how my name can be displayed? For example, instead of “Start”, I want my name “BULU”.

Alok Nath

Creating a shutdown icon is easy. Simply create a shortcut by right-clicking on the desktop and then on New > Shortcut. Enter shutdown -s and continue to finish the shortcut. Double-clicking on the icon will shut-down the computer. Shutdown -s -t 10 shuts the computer down in 10 seconds.

A quick shutdown shortcut can be used to shutdown the system without any confirmation windows.
Problem in dual booting

I have the following configuration for my desktop:
Pentium D820, Intel D945GNT motherboard, 2 GB DDR2 533MHz RAM, 17-inch LG CRT monitor, 500 GB and 160 GB HDD. I installed Windows XP Professional in a 500-GB drive and Windows 2003 server in 160 GB drive. When I connect both hard disks and switch ON the system, it displays booting display screen with both OSs with server 2003 as first one. When I select server 2003, it works normally, showing both hard drives partitions starting from 160 GB to 500 GB. But when I select Windows XP, the XP logo screen displays for around 10 seconds, then the system restarts and shows the booting screen again. When I remove the 160 GB HDD and switch on the system, XP works normally. I want to make it dual boot with options, such that when I select server 2003 it should show 160 GB HDD, and when I select XP, it should show 500 GB HDD. At least, XP and Server 2003, both should run when I connect both HDD so that I have the option of dual boot.

Edwin Paul Menezes

The problem you are facing is because of confusion in boot records written on each of the drives and OSs installed on the larger drive. With the 160 GB connected, make sure you have the correct drive booting up from the BIOS. You can also edit the boot.ini file on each of the drives and correct the entries so that you have the right partition and Windows installation booting up.

XP Not Installing

My hard disk had crashed, so I bought a new Seagate 160 GB hard disk for my laptop. When I tried to install XP, it said that it did not detect any hard disk. I used active boot disk to format it, and created three partitions. Also, it said no hard disk detected. I tried to install Vista, but I get I/O interface errors. Please tell me how to install XP again urgently.

Gaurav Kenue

Your Windows XP refuses to install, most likely because of Windows XP not having the necessary drivers for the SATA controller on the laptop. Download the drivers you’re your laptop or motherboard manufacturer’s site. You need to use a floppy to install drivers when the Windows XP installation begins. You can also use
nLite to slipstream the drivers. Before all this, you can try changing
the mode of the SATA controller to IDE in your BIOS by pressing [F2]
or [Del] when the PC starts.

System Slow

I have a computer with a configuration as follows:
- Intel Pentium4 3.00 GHz with HT
- Intel 915GAG chipset motherboard
- Two DDR 512MB Ram (1 with 333 MHz and the other 400 MHz)
- Seagate hard disks (80 GB PATA and 160 GB SATA)
- XFX NVIDIA Geforce 8800GT graphic card
- Cooler Master 600 W SMPS
- Windows XP Professional

Some days back, I found Trojans on my system using True Sword Trial
Version (win32.backdoor.haxdoor, winfixer, win32.backdoor. IRCBot, HDAudPropShortcut.exe).

I formatted C:, the primary partition and installed Windows again, as the
system was very slow. After installation, I rechecked for Trojans and
removed them using True Sword. However, my system is still not performing
as per expectations. It takes around three to four minutes to start up
Windows. Is this normal? Also, tell me ways to avoid such Trojans that are not
detected by free software like Spybot Search and Destroy. I used the trial
version of True Sword to get rid of these Trojans. Can system overheating
be the reason for slow performance? I checked the temperature of the
processor from BIOS and it ranges from 55 to 64 degrees and with both Zone
1 and Zone 2 around 45 degrees. Is this normal?

Nilesh Thakur

True Sword is a software meant to remove trojans, spyware and
adware, but isn’t really an antivirus. Your processor temperature
of 64 degrees is high, but shouldn’t cause significant slowdown. Three
to four minutes is way too long for a Windows startup. Check to see if
your hard drive has any problems. You can check for this by copying a
large amount of files from one partition to another. Also from device
manager, make sure that all drives on the system are running in DMA
mode. Sometimes Windows sets drives to run in PIO mode which caus-
es major drops in performance.
From The Forum - thinkdigit.com/forum

**XP SP3 upgrade**

I have genuine version of XP SP2 and automatic updates are on. Now, that SP3 is launched, should I manually download it or has automatic updates done it for me? How do I determine?

I came across an article on the Internet that installation of SP3 on computers running the Norton antivirus face problems due to errors created in the registry.

**Sridhar_Rao**

That’s easy. Press `[Windows] + [Pause/break]`, or right-click `My Computer > Properties`. In the system properties, you should see:

- **System:**
  - Microsoft Windows XP Professional (or Home)
  - Version xxxx
  - Service Pack 3 or 2 if that’s installed.

If your SP is still 2, visit windowsupdate.microsoft.com in IE and run Windows Update manually, or just download the EXE file for IT professionals and developers in [www.microsoft.com/downloads](http://www.microsoft.com/downloads). If you have already installed SP3, then no problem.

**dheeraj_kumar**

**XP on 4 GB?**

Will XP Professional support 4 GB RAM?

**mannrak2003**

Is it 32-bit version or 64-bit?

If it is 64 bit, then it will support 4 GB.

**khansaqib101**
How To Verify When The PC Was Last Used?

How can I see when my PC was last used?

ra_sriniketan

If you just want to know when it was last booted, in the command prompt window type:

```
net statistics workstation
```

saROMan

Hibernate

Every time I boot, a hibernate file gets created, despite having been deleted both manually and by tune up utilities 2008. I want to disable it permanently—is there any way around?

manishjha18

I think the hibernation option is itself not turned off, and so the hiberfil.sys is continuously getting recreated. Please disable hibernation from power options in Control Panel and recheck.

debsuvra

NTVDM CPU has encountered an illegal instruction

Whenever I try to execute Turbo C++, I get the following message:

16-bit MS-DOS Subsystem

Turbo C++ IDE, The NTVDM CPU has encountered an illegal instruction.

CS:0000 IP:0077 OP:f0 37 05 0e 02 Choose ‘Close’ to terminate the application. Help me out.

ddpatel78

That’s XP’s fault trying to emulate DOS applications.

Change compatibility mode to say Win 98 in properties and it should work fine.

rayraven

Zeeshan Quireshi

**How To Change Default “My Documents” Location?**

Can someone tell me how to change the location of “My Documents” in Windows XP.

Arnold

To change My Documents location:
1) Right-click on My Documents
2) Click Properties
3) And enter your desired location in target.

Third Eye

Help Installing XP SP2

I have a Compaq laptop worth following configuration

- Intel Dual Core 1.66 GHz
- Intel mobile 965 with integrated graphics
- 160 GB SATA HDD

It came with Vista. But I want to install XP SP2. So when I try to install XP SP2 through a bootable CD, it does not show any HDD. The same problem came when I tried to install XP SP2 in a desktop with Intel G965 chipset motherboard. But there’s a setting in the BIOS, which was needed to be changed to install XP SP2. In the laptop, there is no such setting. What should be done to install XP SP2 in the laptop. Please help.

Note: The BIOS setting in the Intel G965 board was some thing related to HDD, which I changed to IDE.
Two options:
1. Try to find the SATA driver for your HDD and slipstream it to your XP CD, or keep it handy in a floppy or CD and use it when the XP setup asks you if you want to install any third party drivers.
2. Simple method: Go to your BIOS and disable SATA support. If this option is not there, then disable AHCI in your BIOS. You would lose the advantages of SATA by this method, but these advantages are negligible and do NOT in any way decrease HDD speed, reliability or anything else. I’m currently using it this way only.

prasad_den

BOOT.INI Shows Three Entries
I have a doubt. Two years ago, I formatted my friend’s PC due to excessive spyware. I formatted C drive, and then reinstalled XP on the same drive. The same problem occurred and he cleaned the infection and installed XP on his D: drive. Now while booting, it shows three operating systems
1) Windows XP (installed on the D: drive, currently in use)
2) Windows XP (doesn’t boot)
3) Tune Up backup (already uninstalled)
How do I remove this? (from boot.ini?)

Start > Run > msconfig. Press [Enter]
Click on Boot.ini tab
Click on Check All Boot Paths.
If any invalid entries are there, Windows will notify you and you may remove those entries.

it_waaartz_me

Install Vista Over XP
I’m planning to install Vista over XP. Can I just install Vista in another drive? Will it work properly? I have read so many threads regarding it, but didn’t understand properly. Please help. I think my system is incompatible. Please check.
1 GB RAM
Intel G965 Express chipset family
250 GB (SATA) + 40 GB hard disk (IDE)
I currently use XP SP3
Processor is Intel Core 2 Duo 2.2 GHz E4500.
I want to dual boot XP and Vista.

Roonie

Yes, install it on a separate partition and it will take over the boot loader, giving you both OSs to boot from.
Once you are done, download EasyBCD on Vista and edit your Boot options easily.

iMav

If your partition is Fat32, then first convert it to NTFS. Then insert the Vista DVD, run the DVD without booting from it. Run the setup directly through the PC. During the setup wizard, there will be an option called express settings or custom settings Caution: Do Not Select Express Settings, and choose Custom Settings, or else it will install Vista on your current XP partition.

Varad Dilip Choudhari

**Restore Show Desktop Icon**

Can anybody tell me how to restore the Show Desktop icon to Quick Launch bar?

Most Wanted

In Notepad, type the following text on individual lines:

```
[Shell]
Command=2
IconFile=explorer.exe,3
[Taskbar]
Command=ToggleDesktop
```

On the File menu, click Save As, and then save the file to your desktop as `Show Desktop.scf`. Notepad might automatically append a TXT extension to the file name. Remove this extension if present. The file name should be `Show Desktop.scf`. Move this file to the Quick Launch toolbar.

Another way is to run the following command:

```
regsvr32 /n /i:U shell32
```

pushkar
Can’t Delete Vista

I installed Vista by mistake on another partition and now I have had to delete all the files myself. I have been able to delete almost all the files except a few including the Program Files and Windows folders. I keep getting warnings about not having the proper permissions to delete the files. What do I do?

The quickest and simplest way to get rid of these files and folders is to delete the files using a program called Unlocker. It is free and can be downloaded from [http://ccollomb.free.fr/unlocker/](http://ccollomb.free.fr/unlocker/). The program works with other Windows operating systems too.

Should I Go Back To 32-bit Vista?

I am currently using 64-bit Vista on my computer, and there a few proprietary applications made for 32-bit OSes related to security that I can use. I have been wondering if it is worth going back to 32-bit, without seeing any drastic performance drop.

There is no real visible difference in a 32-bit and a 64-bit OS and even in Vista. The only big difference is that you won’t be able to use all of the 4 GB memory. Having said that, 32-bit applications you need to use will run fine on the 64-bit Vista installation. If it doesn’t, then you should probably switch back to 32-bit Vista.

DPI Issues With Vista!

I was using Vista on my large LCD TV and I decided to change my DPI settings for my display on it. I now have extremely large fonts. I can’t see all the buttons to revert to my original settings. What should I do?

If you remember each slider, you can try using the tab key on the keyboard to change the DPI back. If that is too confusing, simply boot Vista into safe mode by pressing [F8] during bootup, and you should be able to make the changes.

Running Applications Quickly

I run Windows Vista and I have noticed that I can run applications quickly by clicking on Start > Run. While some of the applications can be
run simply by entering name of the executable, some don’t run and instead Vista starts looking up information on it on the Internet. Why does it do that and how do I fix it?

If you use certain applications, you can simply pin them up to the start menu, so you can quickly gain access to them. Right-click on the application you want to run and click on Pin to Start menu. If you still want to use Start > Run to launch the programs, create a shortcut for the application first and copy the shortcut into the \Windows\ folder. You can now use the Start > Run method to quickly start up applications.

**Vista Crashing Because Of A Network Adapter**

I have two network adapters, one integrated on my motherboard and an external one using a PCI interface. While using Vista, I have occasional crashes—while booting up and only if I boot up using Safe mode without networking, it starts up fine. What could be wrong?

The culprit is likely to be your network adapter. You may need to download the latest version of the drivers for the network adapter for Vista. You can start by diagnosing which of the two adapters is causing the crash. The simplest way is to go to the BIOS and disable the onboard network adapter. If the system boots properly, the onboard network solution is to blame. If it continues crashing, then it most likely is the PCI network card, so try unplugging it and see if it works fine.

**Removing Preview Pane In My Folders**

In my Vista installation, there is a preview pane for every single folder that I open. Is there no way to disable this pane?

Click on Organise on the left top of the screen, then layout and click Preview Pane.

**Network Goes Dead After standby mode**

I have Windows Vista on my laptop. Whenever my laptop goes into standby and returns, the network connection gives me a Limited con-
nectivity alert. I need to reboot the laptop for the connection to work again. What could be wrong?

A Somehow Vista is not reinitialising the network adapter when it returns from standby. This could be to do with the power saving settings for the network adapter. To fix this, start Device Manager from the start menu. Under Network adapters, look for your adapter. Double-click on it. Look for a power management tab and uncheck the option for Switch off the device to save power. This should fix the problem.

Upgrading Vista

Q I have some machines with Vista Home Premium and I have recently bought Ultimate licenses for them. When I try to upgrade from Vista Home Premium, it refuses to, with an error stating that I cannot upgrade from a staged build to a non-staged version. I have 32-bit versions of Vista and the same problem occurs with and without SP1 installed. Why is this happening?

A You will have to do a clean install for this. For OEM versions of Vista, there is an upgrade option built into the OS.

Tweaking Cleartype

Q I have used Cleartype fonts on Vista for my LCD display. The fonts look too fat and ugly and they are getting a little irritating to read. Is there no tweaking software for it?

A There is an online Cleartype tweaker available on Microsoft’s site. The page is meant for Windows XP, but it works on Vista as well. Visit http://www.microsoft.com/typography/cleartype/tuner/tune.aspx. Choose to enable Cleartype and then follow the steps in the wizard.

Where’s The Sidebar?

Q I remember disabling sidebar immediately after installing, but now when I try to turn it on, it doesn’t come back. It gives me an error saying Windows sidebar is managed by the system administrator.
One of the simplest ways to fix this problem is to get a software called Winbubble. Once installed, run it and click on the Optimise tab and click on the checkbox for Disable Windows sidebar.
Whether you’re a newbie or a seasoned Linux professional, the very nature of Linux distros is to allow you to tweak to your heart’s content. Alas, things often go horribly wrong with such tweaking. In this chapter, we aim to provide Linux newbies with answers to common questions.
How Do You Login As Root In Ubuntu?

I want to login to my Linux machine to the root, but it won’t let me. What do I do?

There is no password set for root and you should not try logging into root in Ubuntu. It’s part of a security feature. Use `sudo` to do whatever you need to do. If you try to run X through root, you might face more problems in the future with other user accounts.

How to Load Evolution Automatically?

I use Ubuntu and I want to have my Evolution mail client start up automatically when I login into my account.

Go to System > Preferences > Sessions > Startup Programs. Click on New, and then enter `evolution` as the application launch name.

RSS Feeds Crashing Evolution

I have certain feeds that make Evolution crash. What do I do?

A new update for Evolution fixes the problems faced in Ubuntu 8.04. You can download the DEB file at http://packages.debian.org/sid/i386/evolution-rss/download

Damaged Partitions

I used a disk-partitioning tool and somehow lost partitions. Gparted shows the disk as empty unallocated space. Have I lost all my data?

Try using Testdisk (www.cgsecurity.org). If it is just the partition table that was tampered with, then you should be able to see it using Testdisk.

How Do I Get Back To The UI?

I somehow managed to get myself stuck in the text console using [Ctrl] + [Alt] + some function key. Now, how do I go back to the graphical interface?
Linux gives you multiple consoles to work and you can quickly switch between these text consoles by pressing \([\text{Alt]} + [\text{F1}], [\text{F2}], [\text{F3}], \text{etc.}\) To get back from these terminals, press \([\text{Ctrl]} + [\text{Alt]} + [\text{F7}].\)

**Clear Bash History**

> All of my commands are stored and I use my direction keys to scroll through my bash history. Is there any way to clear them, in a way similar to how I clear my browser cache?

To clear the cache of your own user account, start a console or a terminal. Go to your home folder, which you should be in by default. Type `rm .bash_history`.

**Java Update**

> I have been trying to update Java, as I have a problem with Java-based applications locking up. I have already installed JDK 6 through Sun’s Web site, but it still doesn’t help.

You should try updating java-6-sun using the following command.

```
sudo update-java-alternatives -s java-6-sun
```

**Disable Ubuntu Updates**

> I like the Ubuntu feature of having constant updates for its applications, but it gets very annoying, so I want it disabled. How do I go about doing that?

First go to `System > Administration > Software Sources`. Click on the Updates tab and uncheck the updates you don’t want anymore.

**Forcibly Delete Files From The Trash Bin?**

> Ubuntu stores all the files in the home folder of each user account. Since 8.04, the trash is kept in `/home/username/.local/share/Trash`. How do I delete them?
To forcibly delete the files, start a terminal and browse to the home folder. Now type `cd home/username/.local/share/Trash`. Then, type `sudo rm -rf *` to delete all the files. Make sure you’re in the right directory, or you could seriously screw things up by deleting all the files in the wrong directory. Use `sudo` commands with care.

**Fedora-XP Dual-boot**

I want to install Fedora, without disturbing my files and XP, with a dual boot option. I really don’t want to format or repartition. Please don’t tell me this is impossible. I just don’t want to lose my data, but want to experience open source. Also, please tell whether I should go for Ubuntu or Fedora.

**Deepak Kumar**

Both the distributions are equally good, but Ubuntu is what most people usually use to start with Linux. You need to partition your drive to be able to use it.

All you need to be sure about is what partitions you have data on before formatting and installing. Make sure you make space for an extra partition and you should be able to go through the installation without losing any data.

Check out Wubi, which is an installer that runs on Windows. You will find it in the latest version of Ubuntu 8.04.

**WinRAR On Linux**

I have some RAR files I received from my mail. They work fine on Windows, but I cannot uncompress them on Linux. What am I doing wrong?

For RAR files to open, you need to install the unrar package. You can do this by starting a terminal and typing `sudo apt-get install rar unrar`.

Once that is done, start up File Roller or the Archive Manager from Applications > Accessories.

Your RAR files should open without any problem now on.
I Hate ./

Q It is irritating having to type ./ every time I want to run a software. Can’t I simply run the binary without the ./ like in the DOS prompt?

A The simplest way to be able to run applications without a ./ is to install or copy the binaries into the /usr/bin directory. You can also add a custom path with your applications by editing the .bashrc file in your home directory. Add an entry export PATH=/home/your_username/your_path:${PATH} where /home/your_username/your_path is the path to where you have installed the binaries.

Firefox Doesn’t Open URLs In Mails

Q The links in my mails aren’t clickable. I can click on them, but nothing happens. I end up copying the URL and pasting it on my browser—Firefox. How do I get Firefox to automatically open the links when I click them?

A Firefox hasn’t been set as the default browser, and therefore, isn’t picking up on any of the Web links you click on. To make Firefox your default browser, first start Firefox. Now open up Firefox’s Preferences. Click on the Advanced tab and check the box for Always check to see if Firefox is the default browser on startup. Click the Check now button.

If this doesn’t work, click on System > Preferences > Preferred Applications.

Make sure Open link in default browser is checked.

Convert NTFS To EXT3

Q I have a 50 GB NTFS partition that I want to be an EXT3, so I can use it within Linux. How do I do it?

A Boot into the LiveCD and use Gparted from the LiveCD on the NTFS partition. Just make sure you backup all your data from the NTFS partition, because once you format you will not be able to recover any of the data.
Transparent Panel

Q I set the colour of the panel to transparent. Instead, it ends up bluish. I have tried using a transparent PNG image as the background, but nothing changes. I use Ubuntu 8.04 along with Compiz-Fusion.

A Try disabling the rendering of the wallpaper in Nautilus, or it might be using an earlier background.

Compiz Crashes Ubuntu 8.04 64-bit

Q When I try to use rotating cube, it works perfectly fine, but the moment I have active applications on the desktop, it crashes and I have to login. It only works properly if the windows are minimised.

I’m using the 64-bit version of Ubuntu, with all the latest updates. Reinstalling the OS hasn’t helped either.

A Try disabling 3-D effects and it should work fine. Keep updating with latest patches.

From The Forum—thinkdigit.com/forum

Restart Services

Q How do I restart a particular service in Linux?

Nach

/etc/init.d/servicename restart

Mehulved

Disable Sound Card In Ubuntu

Q I have dual boot XP / Ubuntu, Two soundcards, One Creative Cambridge Soundworks and ASUS motherboard onboard sound. In XP, the onboard sound is not good as Creative. I have the creative drivers for XP, which makes the sound good. In Ubuntu, Creative doesn’t give 4.1 sound (out of the box installation). Therefore, I need an on-board card to be used by default. When I make it default in Linux, it keeps loosing its setting and switches back to Creative sound card instead. Do I need to install special Creative drivers? Will it then give me 4.1 sound? How can I disable the Creative card from Linux, so
that it’s not detected on boot up, thus giving sound from the on board card? I can’t disable it from BIOS, as I need both of them as 1 in XP 2 in Linux.

ranjan2001

1. To determine the name of the sound cards, type ‘cat /proc/asound/modules’. (In my case, the output will be ‘snd_emu10k1’ & ‘snd_intel8x0’.)

2. Open the file ‘/etc/modprobe.d/alsa-base’.

3. At the end of this file, add
   
   options snd_emu10k1 index=0
   options snd_intel8x0 index=1

   Here ‘snd_emu10k1’ and ‘snd_intel8x0’ are my two cards (Creative and onboard, respectively). After doing this, the card which is given index = 0 (snd_emu10k1 in my case), will become the default.

   I think this will solve your problem. Even if the Creative card is not giving 4.1 sound, you can still use it instead of the onboard card, in Ubuntu.

   unni

Right-click volume control in the Taskbar, open Volume Control > Edit > Preferences. Now select surround and wave surround from the list. Finally, adjust the front and rear speakers. This should give you 4.1 sound.

ranjan2001

Failed To Reserve Range

I have latest version of Firefox 3 through Ubuntu updates, but it has been crashing for me.

gary4gar

Have you got flashgot installed? Disable automatic download manager detection.

Mehulved

Thanks! That solved my problem. Disabled “automatic download manager detection” in flashgot settings.

gary4gar
Auto Mount Drives

Q I can bring the icons of disk to desktop open from there, but I need to open files on my E:\ drive within GIMP on Ubuntu. There I don’t see the drives at all, I tried dragging the files, but that also doesn’t work.

C: Vista sp1
D: data
E: data
F: Ubuntu Ultimate 1.8
All drives are NTFS
Need some direction.

ranjan2001

A Install NTFS-3g or NTFS-config from Synaptic Package Manager.

rahimveron

Desktop Keyboard Shortcut On Ubuntu

Q On Ubuntu, what is the keyboard shortcut for show desktop and to show the application menu? When I auto hide the bar, then show desktop gets hidden and I need to use keyboard. I am used to [Windows] + [D] and [Windows] + [E] to do the above task.

ranjan2001

A Application Menu – [Alt] + [F1]
Show Desktop – [Ctrl] + [Alt] + [D]

chandru.in

A Go to Application > System > Preferences > Keyboard Shortcuts.

rahimveron

Ubuntu resolution problem

Q I’ve installed Ubuntu on my old system. It stays in 1024x768 resolution and my monitor doesn’t support it. However, I think there’s a way to change the startup resolution in recovery text mode. I need the command.

blademast3r
Well, the native screen resolution tool reports the wrong frequency with a proprietary NVIDIA driver. Check “NVIDIA-settings” to see the correct resolution and other details.

praka123

“Out Of Frequency” in Ubuntu 8

I have ATI radeon Xpress 200, which is an onboard graphic card in Intel D101GGC motherboard. I’m using a Viewsonic VA1930WM widescreen monitor. The problem is when I try to install most of the Linux distros like SuSE, Ubuntu and Mint after the boot screen when we press install. The monitor shows an error message as “OUT OF FREQUENCY”.

Vamsikrishna919

Sudo pig-reconfigure deacon and select medium or low

In addition, this bulletproof X is very confusing. It leaves hardly anything in xorg.conf. But it respects xorg.conf though.

praka123

Installing 32-bit Skype on 64-bit Ubuntu 7.10

Can any one tell me how to install 32-bit Skype version on 64-bit Ubuntu 7.10 version?

kin.vachhani

sudo apt-get install ia32-libs lib32asound2
wget -O skype-install.deb http://www.skype.com/go/getskype-linux-ubuntu
sudo dpkg -i -force-all skype-install.deb;

FilledVoid

Software like access

Can you tell me about software for Linux similar to Microsoft Access?

abhijangda

Open Office Base

hullap

Kexi (http://www.kexi-project.org/)

mehulved
Reinstalling XP After Linux

Q I have Fedora 8 and Windows XP installed on my PC. I need to reinstall Windows XP. If I do it directly, will it create problems with my Linux installation? I don’t want to do that. In fact, I did it once and ended up installing XP and Linux again, which took me 3-4 hours. How to reinstall XP with Linux? Is there any way to do it?

ninad_mhatre85

A 1. Install XP as usual
2. Boot from a Linux Live CD, run the terminal and type: grub-install —no-floppy /dev/sda

Qwerty Maniac

Ubuntu Sticks

Q I’m back with another Ubuntu question! Last week, I upgraded to the latest version of Ubuntu. However, my PC gets stuck and does not respond after some time (the interval changes). Nothing works. I have to press the power button to restart or shutdown. What could be the reason? Is there any way to kill the processes that are not responding by any key combinations (like [Ctrl] + [Del] + [Alt] in Windows?)

shobankr

A When your system gets stuck,
   Restart X server by [Alt] + [Ctrl] + [Backspace].
   Press [ALT] + [F1] and check for error messages (if any). If none, then you can login and stop the process via kill command.
   Lastly, safely reboot your PC by pressing [ALT] + [Print Screen] + [R] + [E] + [I] + [S] + [U] + [B].

gary4gar

MTNL Triband In openSuSE 10.3

Q I have MTNL’s Triband Night Unlimited plan, which connects via Ethernet. How do I configure it in SuSE 10.3?

Zegulas

A If there is no dialler, then it should be the same in SuSE. Did you try browsing? If it does not work, Open YaST > Network
Devices > Network Card. Select your card and click Configure. Click on Hostname / DNS tab, uncheck update DNS via DHCP and enter nameserver1 as 208.67.222.222 and nameserver2 as 208.67.220.220. Click on routing tab and enter the default gateway as 192.168.1.1 (the IP of your router). Click Finish.

**Hide Folders**

*Q* How can I hide folders in Linux (Mandriva)?

*Lucky Rathod*

*A* Give it a . (dot) prefix.

>.Foldername will be auto hidden.

*QwertyManiac*

**Multimedia Keys**

*Q* How can I use the multimedia keys on my keyboard in Linux I am using Mandriva 2008?

*Lucky Rathod*

*A* Install and configure Keytouch.

*QwertyManiac*

**Hardware Compatibility**

*Q* My friend has the following configuration:

Processor AMD Athlon 64 X2

Motherboard ASUS M2N8-VMX, NVIDIA-based

He has a problem in installing Linux [Fedora, Ubuntu] with ACPI enabled. He gets an error message. We were able to work with Linux when we tried ACPI disabled. Is this the problem with only that specific piece of motherboard or is it general? I am planning to buy the same

*ggk2k*

*A* I have the same board. At install, give the extra parameter noapic

*NucleusKore*
**ISO Software**

I want an application that can make and burn ISO image files. If possible, the software should have a GUI, and should be minimal in features. I already have k3b, so don’t recommend that.

Hullap

ISO master
Brasero

TD159

**Long Bootup Time In Ubuntu 7.10 (MTA Error)**

I find it’s taking longer than earlier, to boot into the desktop. On closer inspection, I find the following. As soon as I select the OS (Ubuntu), a Ubuntu loading bar shows up. When that bar is about to be filled, the interface changes to DOS mode and shows the following message “Starting MTA”. On displaying this, it just hangs and after about two minutes, it boots into the desktop. On doing a Google search, I came to know it’s something termed as Mail Transfer Agent.

I remember the problem began since I started using Cron/gnome-schedule for scheduling downloads.

What can be done to avert this message while booting up?

cool_techie_tvm

Uncheck this
System > Administration > Services > Mail Agent (exim4)

gary4gar

**Want To Hibernate**

I’m unable to hibernate my Ubuntu 7.10 system, whenever I try to hibernate, my system goes into sleep mode. I’m having 256 MB RAM and 314 MB swap. In addition, how can I assign short cuts to open an application? For example, I want [Alt] + [+] to open xmm

saurabh kakkar

May be more of swap is needed
For the shortcuts, try this
gconftool-2 -t str —set /apps/metacity/global_key-bindings/ run_command_9 “<Alt>”
gconftool-2 -t str —set /apps/metacity/keybinding_commands/command_9 “xmms”

praka123

Can’t Detect HD In DSL

Q When I boot my PC through DSL, it doesn’t detect the hard drive. It works well in XP though. I tried fdisk –l, but it’s not listed. Can it be because it’s SATA? What is the solution?

romeo_8693

A Could be probably because it doesn’t have SATA modules or maybe it doesn’t recognise your SATA controller.

Mehulved

Does that distro have a 2.4 kernel? Better, get a 2.6.15+ kernel distro.

praka123

No dpkg

Q I’m using Ubuntu 7.10

1. When using the command sudo dpkg -i <any debian package>.deb, it says dpkg: status database area is locked by another process. What should I do? I even tried alien but the same error.

2. Till yesterday, everything was fine with Ubuntu. It was automatically mounting all NTFS as well as FAT32 partitions, and was showing on my desktop. I rebooted twice, and in both instances, it wasn’t able to mount them automatically.

I tried to mount them manually, and it didn’t give any error. When I checked the mount points, I found that NTFS partitions were not mounted and only two FAT32 partitions were mounted where as I have more. However, all the mount points were shown and the ones that were not mounted properly were having a cross on their icon. Pen drives work fine.

Ishan
Sometimes when you don’t shutdown Windows properly, Ubuntu might not mount NTFS partitions. Therefore, boot it into Windows and run chkdsk, then boot into Ubuntu and it will surely mount everything again. Have you installed ntfs-3g? Do you still have the folders in /media?

As for your first query, only one package manager should be running at one time, among Synaptic, Update Manager, Add / Remove or dpkg.

Rahimveron

**GNOME Problem after Ubuntu / Sabayon Dual-boot**

I recently installed Sabayon Linux 1.1 Professional edition from a LiveDVD on my PC, which already has Ubuntu 7.10 installed. I shared a common /home partition between both distros under different user-names. After editing menu.lst and /etc/fstab, I managed to get both distros working fine. But now, whenever I boot into Ubuntu, I get the following error just before Start-up music plays:

No exec line in session file kde-3.5. Running failsafe GNOME session instead. Any insight on this error?

shady_inc

It will be a mess with gconf for two distros residing in one /home/ partition. I suggest you run “gconf-cleaner”

praka123

Got over the problem pretty easily! Just had to re-login and select GNOME session from the login screen and make it the default for Ubuntu. Same went for KDE and Sabayon

shady_inc

**Help!**

I have mistakenly disabled all the services from System > Services in my Ubuntu 7.10. Now my Internet and many other services are not working. Also I’m unable to open System > Services. I get an error in the lines of “You don’t have the permission to open...”

Saurabh Kakkar
Open a terminal and run the code provided below for your Internet connection:

```
sudo service networking restart
```

Now you can connect. Once connected, “sudo apt-get install sysv-rc”.

After installing, open a terminal and run “sudo sysv-rc” enable wanted services. Do not edit other services, because as you can see, it shows “don’t mess with this” messages.

Problem solved! I have successfully solved the problem by issuing this command in the terminal

```
sudo /etc/init.d/dbus start
```

Mount

Yet another problem with Ubuntu, my NTFS partitions are not showing

```
abhi_10_20
```

Boot into Windows, then back into Ubuntu to display them. This is caused by improper Windows shutdown.

```
shady_inc
```

Swap Deleted

I have Ubuntu 7.1 installed on my system. Today, I accidentally deleted the swap partition for Ubuntu. Now every time I boot into Ubuntu, it asks me to manually repair the file system. Can anyone help me in doing so?

P.S.: I had two swap partitions, one of which was from the previous installation of Ubuntu, which was on my old hard disk (the one that got deleted). The second swap is still there.

```
Purujitb
```

There is no need to have two swap partitions. Append this to your

```
/etc/fstab
/dev/<partition> swap defaults 0 0
```

Replace <partition> by your second swap partition

```
Anantkhaitan
```
Unable To Log In

I’m unable to log into my Ubuntu account. Whenever I try to login, Ubuntu gives the following error:

GDM. Could not write to your authorisation file. This could mean that you’re out of disk space and your home directory cannot be opened for writing. In any case, it’s not possible to login. Please contact your system admin. This happened when I transferred lot of data in my small Ubuntu partition.

Saurabh Kakkar

Using a Live CD, free up space in the Ubuntu Partition

MetalheadGautham

No Net

I’m using MTNL Triband here. Earlier, I had installed openSuSE 10.3 and I had some bad problems with it. Firefox wouldn’t open any site other than Novell.com. Google, Wikipedia, etc would not open in FF, but they would in Konqueror (but not all the time). I was really fed up, and decided to install Ubuntu. However, the problem remains. I just can’t open any site. I just did a reinstallation (thinking that something might go right by fluke). When I ping the sites using Network Tools, it shows success, but the sites won’t open in FF. I was just about to give up, when I decided to try out thinkdigit.com, and it worked. (What luck, eh?)

I had earlier tried to go by the instructions given by desertwind (on the forum), but then, after I set it to the static IP address, nothing would work further. Typing `system-config-network-gui` in the terminal isn’t working either—it says command not recognised. I did it through System > Administration > Network. As I was saying, even pinging would fail. Also, my router is a D-Link 502T, so I had a hard time there too). By default, the Network shows something like Roaming Enabled. But if I select Automatic Configuration (DHCP), or Static IP, all Net activities stop.

Apt-get isn’t working. Nor can I do anything with the Synaptic Package Manager. The sound is horrible. It’s really small. You’d have to listen very carefully to hear it. At least SuSE was better in this aspect. It also played MP3s.

What could be wrong? Ubuntu doesn’t pack much of a punch without an
active Net connection. This is not a fault of the LAN card driver I presume, because I can ping. (well... I can’t ping microsoft.com).

Anyway, here’s my configuration that you may need to know:

ASUS P5K-VM motherboard (Intel G33 chipset) with an Intel Core 2 quad Q6600, Marvell Yukon 88E8056 PCI-E Gigabit Ethernet Controller, Realtec ALC883 sound card, 2 GB RAM

It’s an x86_64 version of Ubuntu. But yesterday, I had installed the 32-bit version from the Digit DVD.

I really miss the days when the Net worked on Linux on my old PC. I loved it when SuSE automatically configured the connections with kinternet, when I was using raspppoe on Windows. I just needed to click on the plug icon to get going.

Sreevirus

You definitely need to do a `sudo apt-get update` first and then try installing those stuff. It doesn’t have an updated list so it’s not finding anything at all.

Also, disable IPv6 entirely by following this:

1. Do `sudo gedit /etc/modprobe.d/aliases` (or your preferred text editor)
2. Find the line: `alias net-pf-10 ipv6`
3. Change it to: `alias net-pf-10 off`
4. Save the file and reboot

This should fix the slow connections and DNS issue. Also, do try working with OpenDNS to see if the problem lies with your ISP’s DNS.

QwertyManiac

.CHM Files In Linux

How can I read e-books of CHM format in Linux. Which software is needed for it?

cool_callis

GnoCHM or xCHM should do the task.

QwertyManiacInstall

GnoCHM from Synaptic or thru apt-get, if on Debian / Ubuntu. Otherwise, search for the rpm of that software

infra_red_dude
Can’t Edit wvdial.conf

Q I can’t edit wvdial.conf in Ubuntu, it says permission denied. Please help me.

A Open terminal and type:
sudo nautilus

In the window that opens now, navigate to the file and happy editing.

Gigacore

hddtemp Problem (FC 8)

Q Fedora noob here.

I had installed gnome-applet sensors and hddtemp. I have added hardware sensors monitor to the panel. Now under the sensors applet preferences tab, I find only libsensors. It should display libsensors and hddtemp. How can I invoke this hddtemp?

Previously I was on Ubuntu, I remember that after installing hddtemp, a wizard came forth, and allowed me to configure it (like startup at boot). On Fedora, nothing of that sorts happened.

I hope my query is clear enough. Please help me.

iMav

cool_techie_tvm

A Make sure you have installed smartmontools and make sure your HDD is smart capable and enabled. Install hardware-monitor or computertemp, if sensors applet is not working.

praka123

Need Help

Q I have installed Fedora core, I already have Windows XP on my C: drive. Now whenever I start my system, it gives me a screen where I have to hit a key to reach another screen, where I can select which OS I want to boot. Is it possible that instead of the first screen, I get the second screen where I can choose the OS? I want to boot and the first screen gives me only 2 seconds.

vicky_l7

A Yes, just try to boot into Fedora before grub MENU appears. The solution is:

Press [Alt] + [ F2] to get a run dialog. Now insert the following command to open grub.conf.
In the editor, search ([Ctrl] + [F]) for the word hiddenmenu. Comment out (#) hiddenmenu as shown below:

```
#hiddenmenu
```

In addition, you can make the timeout value to be 20 seconds:
Search for and replace the value of timeout.
```
Timeout 20
```

Printing

I want to purchase a Linux-compatible printer preferably with scanner. I have a budget of about Rs 5,000. I have in mind HP LaserJet 1018 or 1200. The other alternative is Samsung ML 1610. Which one would work well? As an alternative, I may take inkjet MFD (Printer + scanner) from HP. Will the scanner work on Linux (openSuSE 10.2). Could some one suggest a model?

```none
praka123
```

Keyboard detection

My keyboard prints these
```
é,â,?,í,ó,ú Ä,Ë,ï,ö,Ü
```
Strange and irritating, as I am unable to type programs quickly while using ¨ or´ ...as each have to be pressed twice to print them...my keyboard was detected as US: International during installation. This is the first time I have faced this problem. In addition, this is not there in Windows, only in Ubuntu.

```none
Vivek788
```

Under Administration, see Language Support. Check your Locale and set it to US.

```none
QwertyManiac
```

edit /etc/X11/xorg.conf to read:
```
Section “InputDevice”
Identifier “Generic Keyboard”
```
Driver  "kbd"
Option  "CoreKeyboard"
Option  "XkbRules"  "xorg"
Option  "XkbModel"  "pc104"
Option  "XkbLayout"  "us"
Option  "XkbOptions"  "lv3:ralt_switch"

praka123

**Harddisk Sectors**

**Q** I believe my friend’s harddisk is corrupted! I run Ubuntu liveCD in his PC for running fdisk in it for partitioning, gave `fdisk /dev/hda` command and then `p` for printing the harddisk’s partition table, it showed no partition, but only the headers. So I tried creating a new partition using `n`, as it asked me I created new primary partition starting from sector 63 to some 10**7. I don’t remember exactly, but it was the default values. It showed up now after creating partition when I pressed `p` for printing the partition table. It showed me the first /dev/hdal partition with default sector size, which I entered. However, below it was written in a note: “partition 1 is crossing the sector limit” or something like that. Without giving it importance, I tried to save the partitions by commeang `w`, but it gave me error “unable to write /dev/hda”. In addition, somewhere in between, it gave the error that harddisk’s sector size is 2048, it should be 512. Hence, nothing was saved in the partition table. What’s the problem? How to change the sector size?

Ishan

A You may need to fix some fs errors. Run `fdisk -v -y -f /dev/sdxx`, where `/dev/sdxx` is the partition, which gives error. Superblock fixing—you should see `fdisk -1 o/p` for more details.

praka123

**Is there any scanner software for suSE**

**Q** I’m having an HP PSC 1315 MFD. Is there any software for Linux / suSE10.3 through which I can use the scanner feature? I need software to scan documents and images in Linux.

bharat_r
Sane-utils. You need to install. I use Debian and Ubuntu. Search sane in yast2 and install. Scanners are supported.
http://en.opensuse.org/YaST_Scanner
http://www.sane-project.org/
http://hp44x0backend.sourceforge.net/

There’s XSane and Kooka you can try out.

SANE stands for—Scanner Access Now Easy

NVIDIA Driver

I’m new to Linux. I just downloaded NVIDIA driver for my Go 7400 card and tried installing it. An error message saying root permission is displayed. I have no idea of how to change the permission. I’m using Ubuntu.

System > Admin > Restricted Drivers Manager > tick you graphics card

Can’t Install Mandriva, SuSE or Fedora

I’m unable to install Mandriva 2007, SuSE-10, Fedora-6 on my system—Core 2 Duo 2.0 GHz processor with an Intel 965 motherboard. When I try to install the Mandriva-07 it will show the error, “unable to find the CD-ROM device”. When I try with the Knoppix liveCD, then it show the error like the filesystem is not found.

Try a distro with kernel 2.6.19 or higher. If possible, try Sabayon. It seems you have some controller, which isn’t supported.

As Mehul pointed out, the 965’s I/O controller hub (ICH8 doesn’t have native PATA support. Therefore, a third party JMicron IDE controller is used, which isn’t supported by some older distros. Hence, it doesn’t detect your CD / DVD drive (which I presume is PATA).

You may try the following, failing which, you’ll need to go in for a newer distro.
First disable AHCI in the BIOS and set it to EIDE. Then boot your distro with the following parameter Linux all-generic-ide

**No Cursor**

I had installed FC7 and Red Hat Linux 5 on my system, which has MSI K8NGM2 motherboard

1 GB RAM
NVIDIA chipset
160 GB SATA
AMD Athlon 64

My problem is that both OSes installed OK. However, I didn’t see my cursor—my mouse is working properly, but there is no cursor. In addition, I changed my mouse, but problem persists.

Are you using a USB mouse? Try plugging and unplugging for udevd to get the mouse detected. Another chance is wrong display size / driver set. May be you can show us your /etc/X11/xorg.conf pasted in http://pastebin.ca or similar sites and link here. Also post your monitor model display resolution, etc. If gpm is enabled, this may interfere with X too.

You should also check GNOME Menu Preferences > Mouse > Pointers for some options. If everything fails, use the swcursor option in /etc/X11/xorg.conf in the Section device part. Option “SWcursor” “yes” or Code: Option “HWcursor” “off”. That may help after a gdm restart. You may need a display driver for NVIDIA. Either open source “nv” or proprietary 3d driver from NVIDIA!

**$PATH Environment**

I installed gEDA suite from it’s ISO image. All went perfectly well, but it said in the end that I need to set my $PATH variable to some directory and some LD_LIBRARY_PATH to the same folder. How do I do that?

In the command line,

```bash
$> PATH=xyz:$PATH
$> LD_LIBRARY_PATH=xyz:$LD_LIBRARY_PATH
```
Unable To Lock Passwd File

Q When I’m creating a user using useradd, it prompts an error “unable to lock passwd file”. I’m using Redhat 9.0 and logged in as user root.

asdfgh2

A Useradd is a raw command. Which distro are you using? Also, you need to be root (admin) user to do that. Try as root. Remember useradd needs many things (mostly auto set) like the default /home/user directory, shell, your details, etc. There are GUI tools available in most modern distros like Debian or Fedora.

praka123

I have deleted /etc/passwd.lock file and now it’s working

asdfgh2

Voice Chat

Q Is there any application that allows voice chat and has cam support with Yahoo! messenger or Google talk?

gpraveen

A Skype and gyach

Mediator

A You can try kopete. If you only want voice chat for Gtalk, you also can try tapioca.

LEARNER_LEARNER

Application Installation

Q In Ubuntu, I used synaptic package manager to install Azureus, but I failed to notice that the version installed was 2.5.0.0. Therefore, I uninstalled it and downloaded 2.5.0.4. I extracted it to a directory and I could run from there.

Now my question is, while 2.5.0.0 was installed, there was a file under Applications > Internet menu. In addition, I could run Azureus just by typing the name from any path in the terminal. Now, I have to go to the path and do it. Can you tell me how to do these two things?

legolas from Digit Forum
You can make a menu listing for your Azureus installed locally. Go to menu System > Preferences > Menu editor. Create a shortcut. If you have extracted Azureus to your /home/user/azureus directory, just give the full link to app fully. You can use run dialog [Alt] + [F2] and run “alacarte” for menu editing. Better, go with Ubuntu Azureus. Remove your current local install completely. Azureus can update locally to the current version when it is connected and stores the files in ~/.azureus.

Don’t worry, remove the mess completely. Apt does the job well. At the end, you’ll get the latest version of Azureus as updates are installed in ~/.azureus. Remove the local install completely and don’t try to install software from source and from Internet in Debian and Ubuntu. The package managers do the job well. For source compilations, there are distros like gentoo, LFS, etc. Your distro (debian-based) got the best package management at present. So enjoy!

praka123
We now move on to troubleshooting the software applications that are most commonly used. Although a rarer occurrence, when they do occur, some of these problems may end in hairloss or wrinkled foreheads. We’ve compiled these from the Digit Forum.
Connect Counter-Strike Steam Over Proxy...

Q I have installed a copy of Counter Strike with steam on my laptop. I use my laptop to connect to the Internet via my desktop through a proxy. If I plug my laptop directly to the BSNL router, CS works fine, but when I connect counter-strike through the proxy, it doesn’t connect.

Does anyone know how to connect steam counter-strike over proxy server?

tweety_bird_bunny

A Real-time games, especially shooters like Counter Strike, are not meant to be played via Web proxy servers. You need a direct connection to play on CS servers. You should check which ports your games use and grant direct access to your laptop over those ports.

Download Videos From YouTube, In Firefox And IE

Q I wanted to know how to download videos from YouTube and other similar sites in Firefox and IE. It could be through any plugin or any standalone software (free OR if worth it then paid)

beanstalk_230

A This is an addon for firefox...


Sites like Viddownloader allow users of any browser to download Flash videos from sites like YouTube

Kenshin

Note: For those who want to download YouTube and videos through any browser without installing a plugin, there is a site www.viddownloader.com, which lets you do just that.

“???????????” Displayed Instead Of Text

Q Question marks, is what I get so see in place of text when I open some
blogs. What’s the cause and what would be the solution?

Rudick

It's not a browser related problem. May be you do not have the required font. So please check if you have all the basic fonts installed.

rohan_shenoy

Resume µTorrent Downloads

Q I had to replace my motherboard (Intel 845GV) and reinstall my OS (Win XP). Now, when my desktop was working well, I was downloading stuff and most of them were almost complete (97 per cent). What I want to know is if there's any way by which I can resume from where I left off. I have already backed up my partially downloaded files to another drive. If possible, how do I do it? Help me out guys. Thanks in advance.

apoorva84

Q I have downloaded a torrent file, but only 80 per cent is completed. This happened on my cousins PC, now I brought those files (the ones in downloaded folder) to my house and copied them to my PC! How can I download the rest of the file? Can anybody please help? I tried copying it in my downloaded folder, but it doesn’t show up in the torrent engine. What do I do? I use utorrent.

bhadkow

A You will need µTorrent, and also the same torrent file (some KBs) that you were downloading. Now do the following:

1. Place all the contents (the incomplete downloaded files) in a folder that you want to download to.

2. Double-click on the torrent file, and if µTorrent is your default, it will ask you where to save the download.

3. Point it to the same folder where the partially downloaded files are. The µTorrent application will start checking the files (in percentages), and will continue from where it left off.

ashu888ashu888

Note: The same should also apply for other Torrent clients. just make sure to keep a backup of your partial downloads, just in case.
TATA Sky to PC!

Can I record Tata Sky channel programs on my PC using a TV tuner card?

**solomon_paulraj**

You can do it by connecting the output from STB to your TV tuner’s AV-in.

**narangz**

You can capture channels using the TV tuner card by connecting using AV or RF code, one channel at a time.

**Carnage13**

Note: You cannot use the advanced features of the TV Tuner software though, to record from a particular channel at a certain time when you’re out, or to get the TV Tuner to change the STB to the right channel on it’s own. With a lot of manual intervention, however, it’s perfectly manageable.

PlayStation 2 on PC

I need software (freeware) so that I can play PlayStation 2 games on my PC. My system configuration is:

- Intel Pentium 4 Dual Core 1.60 GHz
- 1 GB RAM
- 160 GB Hard Disk
- NVIDIA Geforce 7050 / NVIDIA nForce 610i
- 19-inch TFT monitor

Please reply

**Safika Ahmed**

PCSX2 although still in development allows quite a few PS2 games to be run on the PC
PCSX2 is the most well known PS2 emulator for the PC. It has been development for a long time and in recent times, they have been able to run quite a few games with decent performance and few bugs. PCSX2 can be freely downloaded from www.pcsx2.net.

**Requesting Help**

Ever since I have upgraded my computer, I am facing a problem. My earlier configuration was too slow to meet my movie editing requirements. That is why I have upgraded it to a more powerful configuration. My particular problems are:

1. I have been using Pinnacle Studio Version 8.1 to edit my home movies. Now, I cannot shut down my computer after installing the software. It restarts repeatedly. The Error Signature is shown as: BCCode: 1000000a BCP1: 00000000 BCP2: 00000002 BCP3: 00000000 BCP4: 804EF13C 05Ver 5_1_2600 SP: 2_0 Product 256_1. I have already removed and re-installed three times but the same problem happens.

2. The same problem (re-starting while shutting down) happens when I install the software that comes with my handy cam Sony DVD 805 (which did not happen with my earlier computer).

3. Therefore, I tried to edit the movies in Window Movie Maker. Later, the problem appears with the message “Window Movie Maker has encountered a problem and needs to close. Tell Microsoft about this problem” and then the program closes without a chance to save my work. The Error Signature report contains: AppName: moviemk.ex , AppVer: 2.1.4026.0, Modname: ntdll.dll ModVer: 5.1.2600.2180 , Ofset: 00018fea.

Please help...

My computer configuration is:
Mother Board: ASUS P5K Premium
Processor: Intel Core 2 Quad Q6600
Graphic Card: NVIDIA GeForce 8500 GT
Ram: Kingston 2 GB dual-channel at 667 MHz
OS: Window XP with SP 2.

Temsula Lemtur

There is a good chance that you have faulty memory. If you have two sticks, then try removing one of them and look if the problems persist. Do the same with the other stick. You can also try run-
ning Memtest86+ (www.memtest.org). Download one of the images from the site and burn it on a CD. Boot using the disc and run a thorough memory test to look for issues with your RAM modules.

**Oblivion Crashes**

I have an assembled PC with an ASRock ConRoe865GV motherboard with a Pentium 4 processor, 1 GB RAM, GeForce 6200 AGP graphic card running on Windows XP. I recently bought Oblivion, and played for it for a couple of minutes. However, the system crashes with a blue screen and some weird figures, numbers and letters appearing. Well, they do make sense, but pass away in a flash. This happens every time. Help!

Vipul Hembrom

Try updating the drivers for your motherboard and the graphics card. The problem could be related to the power supply. Look for heating issues with the processors. Look in the BIOS for the temperatures of the processor.

**Pixelshader 2.0 Not Found**

My PC details: Motherboard Intel 82945G

RAM: 1 GB

Hard Disc: 160 GB

Processor: Pentium Dual Core 2.0 GHz

My motherboard is Intel 82945G and it has 128 MB video memory + pixelshader v2.0. (I have confirmed this by running PC wizard 2008). Now when I try running “Hard to be a god demo” it says pixelshader 2.0 not found. When I run “Pro evolution soccer 2008”, it shows the same message with an additional ignore button, which if I press, the game runs. Additionally, GTA: San Andreas and NFS Pro Street also crash after a black screen.

I have the latest video and audio drivers and DirectX 9c. What should I do? I have recently upgraded my computer. Should I call the computer vendor? (I don’t think he is such a geek). Should I reinstall Windows XP?

Prakash Gourav

Your onboard graphics solution is supposed to support Pixelshader 2.0, but there are many reported cases where games refuse to run on it. You should try installing the latest DirectX redis-
tributable runtime. The latest one was released in June and can be found in this month’s DVD.

**How To Convert Songs From MP3 To RM**

I have Intel Core 2 Duo with 1 GB RAM, running Windows Vista Ultimate. I have audio songs in MP3 format, and I want to convert them to RM. Is there any way?

Mohit Shah

There are software available to convert MP3 and other audio formats to RealAudio. Audio Tools Factory’s MP3 RM Converter (www.audiotoolsfactory.com/mp3rmconverter/mp3rmconverter.htm) is commercial software, but a trial version is available on the site.

**PC Problems!**

I’m having strange problems with my PC since the past 2-3 days. When I’m using any Web browser (Opera Beta and IE5), on pressing the [ A] or [ X] key, it takes me to the previous Web page. It’s happening with both the Web browsers. Initially, I thought it was a problem only in the Web browsers, but the same problem occurred when I was using Windows Explorer—with a subfolder open, pressing [ A] takes me to the previous folder!

Another strange thing that’s happening is that when I press [ 1] on the main keyboard that is above the qwerty line, it gives an output “0001”. If I delete it using backspace, and press [ 1] again, it outputs “1000”! This is not happening with the other numeric keys—either on the main keyboard or the num pad.

Why does this happen? How can I revert to normal? Is it a virus attack? I
have the following software installed:

AVG 7.5 Free version, Ashampoo antivirus (from your May CD), Comodo
firewall Pro. My PC Configuration is: Windows XP professional Version 2002,
SP2, Intel Pentium 4 1.8 GHz, 384 MB of RAM

Shivalik Daga

It could possibly be a keyboard problem. There are a few things
that you need to check. The simplest would be to get a different
keyboard and see if the problem continues. You can also try using the
onscreen keyboard in Windows. Go to Start > All Programs >
Accessories > Accessibility > On-Screen Keyboard. If possible, try booting with a Linux LiveCD or into DOS and see if the prob-
lem persists. If it does, then you might need a new keyboard.

.NET Framework Issues

My name is Chirag and I’m hav-
ing some issues with .NET
framework, which is installed on my
PC. They are as follows:

1) I have to click on my user
account on the welcome screen, even
though I’m the only user and do not
use any passwords.

2) Windows Media Player 11 does
not play DVD movies when this .NET
framework is installed.

My system configuration is:
ASUS M2NPV-VM motherboard
2 GB RAM
Liteon LH20A1P DVD drive
Seagate Barracuda 250 GB Hard Disk Drive
Windows XP SP2

This is the most annoying part, as I want to use Google Sketchup that
you’ve provided. It needs the .NET framework installed. Besides, I even have
some DVDs to play. Please help. Thank you in advance!

Chirag
To have Windows auto login, the quickest way is to click on Start > Control Panel > User Accounts and uncheck the box for Users must enter a user name and password to use this computer.

.NET Frame should have nothing to do with DVD playback on your PC. Try using some other player for your DVDs to see if it works. Try Media Player Classic or VLC Player (www.videolan.org) if you have to play DVDs. You can also try uninstalling Windows Media Player 11 from the Add / Remove Programs feature in the Control Panel. Make sure to check the box for Show Updates. Under Windows XP updates, you should be able to remove Windows Media Player 11.

**WMV > DivX**

Please suggest software to convert WMV files to DIVX. Do mention if they are available on any Digit DVD / CD, since I am unable to run it on my computer (550 MHz, 128 MB RAM, 32MB VRAM).

Arighna Mitra

A free Open source software called alltoavi should be able to help you convert WMV files to AVI using any supported codecs. It is available for download on http://alltoavi.sourceforge.net.

**Slide Show**

I had taken photos on a DSLR, each with a size of around 1 MB. After making a slide show with embedded music, the file size of 20-22 photos becomes some KBs. Also, while viewing on full screen, pixels are visible as the quality degrades while preparing the slide show. I tried Nero, Windows Movie Maker and Picture Project software that came with Nikon D 40X, but with the same problem. I do not want to change the quality / resolution of my photos. Which is the best software available for this purpose?

Shrinivas Bhatawadekar

Most likely, the video or slideshow you have made has resized the image down to low resolutions, which should explain the
size and the pixilation. It could even generate thumbnails of the images. If you are planning to make a VCD or DVD, you will see a big drop in quality, just because of the resolution limitations of the format. While your photo might be of a resolution of well over 3072 x 2304, a DVD video resolution is around 720 x 480. The best solution to preserve quality would be to use some kind of image viewer such as Irfanview to view images from a CD on a computer.

**.PST Password Recovery**

I have forgotten the password to my .PST file. How do I go about recovering it? Is there free software available for this? I have tried demo versions of various software. But they are not very helpful. Please help. The file contains some important mails.

Sujit N. Pawar

The only solution for password recovery we can give you is to try more such software. PstPassword is one such freeware, which can be downloaded from [www.nirsoft.net/utils/pst_password.html](http://www.nirsoft.net/utils/pst_password.html).

**Converting Real Player Recordings**

I have recorded video using Real Player 11 Gold Edition. It has recorded as “.IVR”. I can't convert this file into .AVI file using total video converter. Is there any way to convert that file? If so, please tell me how to convert it.

Vinoth Kannah

.IVR formats cannot be converted to AVI's but there is a workaround for it. You can burn the video to a DVD using the Real Player application itself. The burnt DVD can be ripped using a DVD ripping software to an AVI or any other format for that matter.

**PCSX2 Emulator**

I had downloaded the pcsx2 (the PlayStation emulator) from the site and installed it. After installation, I inserted the PS2 game DVD. When I clicked on File > RunCD/DVD, it reported an error saying it cannot load BIOS “can’t run without that!” What should I do! Please help me!

Pankaj Patel
For the PS2 emulator to run games, a system BIOS file is required. A BIOS dumping utility is available on PCSX2’s site that can grab the BIOS for you.

**Wireless Problem**

I have a Dell 6400 Inspiron series laptop and it has Intel pro-wireless 3945ABG card. From the past few days, whenever I stop browsing for about an hour, Internet stops working and when I try to repair the connection, it is unable to get the IP address. The only solution is to restart the system. I have tried reinstalling the driver, but of no use. This is the latest driver for the device. I have also scanned the whole system and did not find any virus.

Ankur Jain

The problem could be on your end or maybe even on the wireless router, if you are using a wireless connection. If the router belongs to your office or your ISP, then there is a chance that there is a timeout period set for the connection.

Instead of rebooting your system, try disabling and enabling the network adapter by clicking on Start > Control Panel > Network Connections. The problem could be on your ISP end.

**Fast Torrent Download**

I am downloading some data from a torrent site, and getting a downloading speed of 8-10 kbps. I have heard that through torrent, we can get more than normal downloading speed. I use BitTorrent 6.0.3. Could you please tell me how I can increase downloading speeds? I have a BSNL broadband connection.

Vishal Bhatia

Using BitTorrent doesn’t mean that you can get more speed than your connection is meant to deliver. A BSNL broadband connection means you should have a 2 Mbps or an 8 Mbps connection, which means speeds of well over 200 Kbps. It is recommended that you use uTorrent as your torrent client and set a healthy upload speed for your connection.

If you have an ADSL router, make sure that you have your port for-
warding settings set up properly to allow incoming connections from the Internet. First set a port on which your uTorrent will run from the Preferences and allow that port to be forwarded to your computer. uTorrent has a port checking page, which allows you to see connections that can be sent to your PC from over the Internet.

Nero A Problem

My brother erroneously tried to install Nero 7.0.1.2 in Vista and ended up with some error. He said the installation just crashed and gave some message. Now I purchased Nero 8 and tried to install it on Vista, but after starting, the installation gives a message that Nero 7 is detected on the system. If you want to install Nero 8, press OK to automatically remove Nero 7 or press cancel to remove it manually. But when I press OK, the program gives no action and just vanishes. I tried to manually uninstall the same through add remove programs, but failed. Nero is listed in the add remove program list, but not elsewhere, even in program files folder. I also downloaded Nero general clean tool from the Nero site, but it’s not detecting it.

Solve registry issues with the help of ccleaner
Please help me for removing the older version of Nero from Vista and install Nero 8.

Sujith Sugathan

The program may not have been uninstalled completely, so a few files and registry keys are bound to still be on your Windows installation. Use a registry cleaning utility such as CCleaner to uninstall the remainder of the program and clear out your previous versions of Nero. If that doesn’t work, first backup your registry and then try searching for Nero registry keys and remove them manually. Also, ensure that the Nero installation folder from your PC has been removed.

DLLs Missing

I have a 200-GB hard drive, 1.8 GHz Intel Pentium dual core processor and 2 GB RAM on a 945GC-M7 TE main board with XP SP2 installed in it. Of late, I installed Comodo firewall and Ashampoo antivirus. Yesterday, I ran a full system scan and deleted all the viruses showed in the scan. Now the system is taking ages to startup. It also shows ardpjdrk.dll and tfqxmbnf.dll as missing.

Manish Hemnani

When you installed the Ashampoo antivirus and scanned your system for viruses, it removed the virus files but the links to these files still exist. Use CCleaner to remove all unwanted registry keys and links.

Copy Error

I’m trying to copy a movie CD on my PC, but an error occurs as “Invalid MS-DOS Function”. The CD is fine, because no error occurs while copying it on other PCs. Please help me.

I use Windows XP2, 512 MB RAM, P4 Intel processor configuration

Amit Singh

Certain discs, especially movie discs come with copyright protection, which will not allow you to make copies of it. The Invalid MS-DOS function error message could be the result of that protection. It could also be a problem with your drive not being compatible and
finally it could also be the disc itself being scratched or damaged.

**Hanging Problem**

I have a Dell Optiplex 755 PC. My configuration is as follows:

Intel vpro, Core 2 Duo E6650 @ 2.33 GHz, 1.96 GB RAM, GeForce 7300 GT 512 MB RAM, Creative Audigy Value soundcard. I am using Windows XP and Vista, but mostly XP. There seems to be a problem in some of the games that I play, such as in the case of *Gears of War*, the play speed is fine, but the PC seems to hang occasionally and I have to turn it OFF and then ON again. It so happens that if I play it again, it hangs again not necessarily at the same place. As *Gears of War* is a heavy game, I would like to mention that I played the *Simpsons* game, which is very light, and that also hangs my system and it freezes. This is not the case with other games that I play, such as *NFS: Most Wanted* or *Carbon*, etc. However, occasionally it also may hang while playing them, even after long play times. Kindly help me. Is it a problem with my graphics card or what? How can I deal with it, I have the latest drivers installed as well.

Saurav

The lockups could be because of drivers. Update drivers for your motherboard and graphics card. If the problem exists in both Windows XP and Vista, then there might be a problem with your graphics card heating up. Download a heat monitor such as Speedfan and monitor temperatures for the card and processor.

**IE 8 Restarts**

I use Windows Vista Ultimate. My configuration is Intel DG33FB motherboard, 4 GB RAM, Core2 Quad 2.4, NVIDIA GeForce 7200GT, 250 + 80 GB hard disk and a broadband connection. I use IE 8 Beta 1. Every time I right-click on IE, I get an error and IE restarts. It happens every time I connect to the Internet. Please help me with this problem.

Partha Sardar

Internet Explorer 8 is still in beta and there are bound to be stability issues with it. A fix could be click on Tools > Manage Addons. Look for all the currently enabled addons and turn off the addons one after the other to see which one caused the crash.
Help Please

1. I use IE 7 and a message box pops-up every time I close the browser. Help to rectify this annoying pop-up!
2. I get the “rundll” error at every start up. I use 1 GB RAM, 160 GB HDD and a Pentium 4 processor. Help to rectify this annoying pop-up!
3. I want to create a backup of all the automatic updates that are installed on my system through the Internet. I want to do this because you might know that Microsoft will be stopping its support for XP on June 30 this year. Also, I found the setup files for the updates in the /windows/software/distribution/download, are these the setups? How can I do that?

Shreyo

A

1. The Internet Explorer 7 crash could be because of faulty memory in which case you should run Memtest86+ (www.memtest.org). You should also update your motherboard drivers.
2. You have some kind of malware on your system. Fortunately, one of the easiest ways to uninstall this is to go to Add/Remove Programs from the Control Panel. Look for an application called new.net and uninstall it. You should install an antivirus or use a free online scan to get rid of it completely.
3. Microsoft XP downloads all the updates to the folder—\WINDOWS\SoftwareDistribution\Download. Back up the files in it to a CD or DVD for later use.

Upgrade

I have a desktop with a 17-inch monitor, 80-GB hard drive, Intel Pentium 4 2.8 GHz, ATI Radeon Xpress 200 Series, 1 GB of RAM and Windows Vista Home Premium OS. Everything was running fine. I even have installed the Spider Man 3 game successfully. However, when I start the game, I get the sounds but no display. So will a graphics card solve my problem, or do I need some other remedy. Please resolve the problem under Rs 10,000.

Rajesh Ranjan

A

Spiderman 3’s minimum system requirements state that the graphics card should support Shader Model 3.0 which your Radeon Xpress 200 solution does not. You need to invest in a graph-
ics card. Invest in a graphics card such as GeForce 8800 GT or something a little cheaper such as a GeForce 9600 GT or 9600 GSO. It would be better if you update to a new system with a dual core processor. If you aren’t plan on upgrading very soon, then a GeForce 8600 GT will suffice.

One Key Recovery

Q I have a laptop, a Lenovo 2048-22Q. There is a OneKey Recovery function on my laptop that can recover my C partition. One day, I formatted my hard-disk and the function got disabled. I tried to enable it but I simply can’t. What can I do to solve this problem?

Kedar Kulkarni

A OneKey Recovery is a third party application that runs on the Lenovo laptop but formatting your hard disk would have removed the feature from the laptop. You should reinstall OneKey Recovery again if it has been supplied on one of the discs. Create the necessary backups once that is done.

Problems Installing Software

Q I am experiencing some problems with my computer. Whenever I try to install a program, it gives me an error. It reads “The system DLL user32.dll was relocated in memory. The application will not run properly. The relocation occurred because the DLL C:\WINDOWS\System32\SHELL32.DLL occupied an address range reserved for Windows system DLLs. The vendor supplying the DLL should be contacted for a new DLL.” I cannot install any application which comes as an executable. but programs run fine. My computer configuration is:

Intel Pentium D 820 processor, Intel i945G motherboard, 80 GB HDD, Windows XP SP2. I have also installed Flyakite OSX 3. What steps should I take?
Installing Flyakite OSX 3 is causing that error to pop up. Uninstalling Flyakite OSX 3 will fix the problem, but there is also a Microsoft fix which can be downloaded from http://support.microsoft.com/kb/935448/.

**Restrict Browsing**

My friend has an Internet café. He recently installed a 2.5-GB download limit, BSNL Broadband Connection. How can he restrict video and software downloads by any means with a specific quota per PC, and with a download reading software.

I don’t know about Ethernet sharing. Please suggest some effective proxy servers that restrict certain sites, for example, pornographic sites and downloading.

Please guide me on how I can share the Net via an Ethernet proxy server. I have an ADSL 2+ modem with 4-Ethernet ports.

Dileep

Certain ADSL routers can allow you to block access to sites directly through the router’s interface. If you run Linux on the main gateway server, Squid is the best solution you can use, which has built in bandwidth throttling and restriction features. There are also standalone bandwidth throttling software such as Netlimiter which can be installed on client machines and allow remote access to the speeds allotted.

**Orkut Help**

I want you to help me out as I am having problems with Orkut. My Orkut account keeps on redirecting. Also, it shows a message that the SSL certificate has expired or not yet valid.

Kohli Radu

Orkut had a temporary issue, which would have led to the SSL certificate expiry error. If the problem still persists, clear the cache on your browser. If that doesn’t, try a different browser to see if you face the same problem.
From The Forum - thinkdigit.com/forum

Record Streaming Radio

I just wonder whether it could be possible to record online streaming radio. I used to listen to a weekly podcast on http://www.hit967.com/. Sometimes, I miss the show due to my schedule. I would like to know if there are any programmes available which grab the show from this station and store it on my system, so that I can hear it later in the day—it’s a two-hour show.

Keves

You may try this freeware called screamer radio. You can also record. www.screamer-radio.com

Ramakrishnan

Check Video And Audio Quality?

Suppose I download a video of XVID AVI format, how can I know the quality of audio and video? The problem is that one can stretch the actual video and make its size bigger. So, one may convert a DVD-quality video to an HD-DVD quality and then it will be hard to detect the difference by watching the video. So, is there any way to know the actual size of the video and actual bit-rate of the audio?

Udaya Maurya

Open with Media Player Classic. [Shift] + [F10] > Details

You can also use GSPOT codec finding tool, which gives all the information about the file

New

Can’t Play Games

I’m not able to play the following games: Call Of Duty 4, NFS Pro Street Demo, Crysis Demo, Stranghold, The Witcher Demo or any big games that I have got on Digit DVDs.

The installation succeeds without any problem, but the games are not running.

Ashok Verma
Your system is just not powerful enough to run those games. To play the above mentioned games, you need at least 1 extra GB of RAM and a decent graphics card.

**latino_ansari**

**How To Add Software To XP Installation CD To Installs Automatically?**

**Q** I have just customised my XP installation looks and background. I wish to add software to install automatically during the XP setup. Could someone please help?

**Anjesh Shekhar**

**A** Use nlite. nlite is the best way to add software, drivers, updates, etc to your XP installation. It gives you the freedom to edit the settings prior to installation.

**sabot and Techtronic**

**New Folders**

**Q** The folders ff0f0a219308ae522998da6110d119af and MyWorks have been created in my G:\ drive. What are they?

I never added any items to it nor installed any software having path G drive. Then how did they appear?

Let me tell you that my system has five partitions and G is empty. I never added any thing to it. However, when I just opened it today, this is what I saw.

The ff0f0a219308ae522998da6110d119af folder contains many files, while the My Works folder is empty. When I try to open any file, it says access denied! What is the reason? How did all this come there? Should I delete them? I scanned the partition with Nod 32 but it does not show any virus and most of the files cannot be scanned, or are denied scan. There are lots files in it. Something like asferror.dll, audiodev.dll, mediareceiverregistrar wmdbexport wmp11 wmp.dll wmpband.dll wmpencen.dll wmpnscfg

**life31**

**A** It seems you have an incomplete installation of Windows Media Player 11. Reinstall wmp11, and when its fully installed and cannot delete the folder, try this:
Install Unlocker, right click that folder and click Unlocker. Click “Kill Process” or “Unlock All” or reboot if it says “delete at next reboot”.

**Set IE As The Default Browser?**

**Q** Currently I have Firefox as my default browser. I need to set IE as the default. How can I do this?

**Sarincv**

**A** Go to Tools > Internet Options > Programs > Default Web Browser.

**sanyaldk**

**.CHM E-books To Other Formats**

**Q** I have some e-books in CHM format. I don’t like this format because I can’t increase the font size and it’s difficult to read them. How to convert these CHM format books into other formats such as PDF or DOC?

**kantiman**

**A** Hey, I too had some problems with them and I tried many software. Those which worked for me are:

- Help and Manual4, and CHM to PDF converter pro
- I used both of them to convert to PDF. It’s easy to use both of them. Just open a CHM file. Then, the software will decompile it. Finally, save it to PDF.

**rajdeepsingh86**

**Enable Autorun Without Reloading Windows?**

**Q** When I insert external storage devices like CD, DVD or a pen drive, autorun / autoplay is disabled. Is this because of a virus? Can I enable it without reloading my Windows? I’m using Windows XP SP2. Please help.

**Hluahawngthu**

**A** Try right-clicking on the DVD drive icon and go to properties. Click on the second tab Autoplay and select ‘prompt each time’.

**ayush_chh**

You can re-enable it using TweakUI. Believe me, you are better off
with autorun disabled. In fact, I’ll recommend disabling autorun on removable drives also. These days, pen drives are the most common channel of spreading viruses.

\[ it\_waaznt\_me \]

**HD Conversion**

Q This is a question which has plagued many of us since we saw HD content. How are normal movies converted to HD? Is it a software process or some special hardware is needed? If a software, then please name it.

Hope to get some quick and good replies soon

\[ Rudick \]

A Those movies are shot at much higher resolutions and they scale down to fit DVDs. It’s much easy for them to release the HD versions. Nowadays, most of the movie cams are capable of shooting at much higher resolutions than 1080p and are saved in RAW formats.

They can later just encode it to whatever formats they need, in order to fit in corresponding discs like BD, DL DVD, DVD, etc. In fact, there is much more, but we don’t need to know all these. The best quality copy we can get on the market is 1080p on a BD or HVD disc.

\[ dOm1naTOr \]

**All In One Client**

Q Instead of GTalk, Yahoo! and MSN Messenger, is there any software from which we can access all the accounts and chat from our desktops?

\[ Rudick \]

A There are many of them. For example, pidgin:  http://www.pidgin.im/download/windows/

\[ iMav \]

Note: Some other options are Miranda (www.miranda-im.org).
Trillian (www.trillian.cc) and Digsby (www.digsby.com).

**What Is My IP?**

Q I'm a BSNL Dataone home user with a 500 plan. I login to my modem settings using the IP 192.168.1.1. In Windows, my IP address in the TCP/IP properties in the network settings is 192.168.1.136. When I open sites such as www.portforward.com, it shows my IP as 117.XX.XX.something. Which of these is my actual IP address? Then what are the other two IPs? Do I have a dynamic IP?

ajaybc

A The 192.xxx.xxx.xxx IP address is your local IP for your LAN. The 117.xxx.xxx.xxx IP is your external Internet IP that is reported by the site you have mentioned. Most ISPs allot dynamic IPs to their clients.

**Wedding DVDs**

Q I need to join three wedding files from three different CDs. I need to make an autoplaying DVD.

mkmmkmk

A To make a continuous DVD, you do not need to join the video files. If you do so, it will unnecessarily take a long time. Just use any DVD authoring software like Nero vision to make a DVD with menus.

Cool Buddy

You can use DAT Joiner (http://www.321slideshow.com/dat-joiner.htm)

KoolKid

**DVD Using A UIF File?**

Q I have a UIF File of around 3.17 GB. How can I write it on a DVD? Nero is unable to do that.

satyamy

A I guess you can use MagicISO image file. You can use it for burning as well.
Find MAC Address Of LAN Card

Q I have a PC running a LAN Internet connection. Now I need to run the same Internet connection on my laptop. For this, I manually need to change the MAC address of the LAN to that of my PC. How can I do this? How can I find the MAC address of my PC? I used ipconfig /all, but I’m confused because it gives a 10 to 15 line reply. Which one is the MAC address?

satyamy

A It’s the one with the following form: 01:23:45:67:89:ab

preshit.net

For changing (spoofing) the MAC address, you may use the freeware program MAC makeup from http://www.gorlani.com/publicprj/macmakeup/macmakeup.asp

Ponmayilal

Cassettes To CDs

Q Tell me how to convert CDs. What are the requirements? Please tell me. Please explain it to me in detail.

JohnephSi

A First, check that your tape has line-out pins. Then buy a cable having two line-out and one mic-in for your PC. Connect your tape’s line-out with your PC’s Mic-in pin through the cable. Start your tape and record the voice in any recording software.

If you have problem finding the cable, just get your tape and go to any TV / electronics repair shop. You will get the cable for about Rs 30 to 50. This way, you will get good quality in audio.

parthbarot

Machine Image To CD Or DVD

Q I have recently formatted my machine, and do so frequently. So I heard about taking the image of the computer in a DVD or CD and putting it back when ever needed. Can any body help me out in this? I have an 80-GB machine with a single C: drive. Suggest a good one.

jayanbhm
With Acronis True Image, you can easily make disc images. Acronis also allows you to split the image to fit in optical discs. But a single 80-GB partition image will take you around 18 DVDs!

---

**Reduce GIF Files**

How do I reduce a GIF animation size?

*Rockstar11*

Use Imageready. Delete some unnecessary frames, and reduce the dimension.

*Lucky_star*

Yes, Imageready is the best and is easy to use. Delete the frames which you don’t need and speed up or down as you want.

*ax3*

**Extract 5.1 Audio**

I have an original DVD having 5.1 channel audio. I want to extract audio for one of the songs in 5.1 channel format only. How can this be done?

*rak007*


*Rockstar11*

**Automate Downloading**

Hi. I am a frequent downloader of big files using Torrent. Now I have a BSNL 500 plan, that is, unlimited from 2 to 8 am. It is troublesome to wake in the night, go to PC, start it, wait for the link, then connect, start the torrent and sleep!

Shutting down is not a problem, but the main thing is to wake up at night. Is there any software which can self connect to the Net, using the present connection at a pre-determined time, and then start the torrent software. I have to only turn the PC ON and modem for say between 11:00 to 12:00 pm. In case the PC restart or link gets broken it should be able to reconnect.

*ayushman9*
I am looking for a tool to turn on Windows at a specific time, but didn’t find any. Please help me if you find any. Thank you in advance.

Rakesh Rao


dheeraj_kumar

CD Problem

I use windows XP (Home edition, SP2) and I am using Nero 5. I have recently added a combo drive (DVD reader + CD writer) of IBM. Now my Nero doesn’t accept it and I can’t burn any CD. Is it due to a virus problem or Nero needs to be upgraded?

Bishwadeep Bagchi

You should upgrade your Nero to a newer version to add support for your drive. In the meantime, you can also try some other free alternatives like CDBurnerXP (http://cdburnerxp.se)

Install MySQL

I’ve bought a domain name and Web space for my Web site. It’s a Windows server for hosting. I have built a Web site with MySQL database. Now, the problem is that, there is no MySQL server installed on the
Web server. I must have MySQL installed on the server to run the Web site.

Similarly for Tomcat, I made JSP pages, which need Servlet engine to parse. Normal Apache server can’t parse JSP files. So, can I installed Tomcat server on that server (or on different port)? Otherwise, I’ll have to convert all my JSP code to PHP or ASP. I have FTP access to the server, that is, I can download and upload files on that server. Any way out? Please help.

Garbage

Do you own the server? I think only if you have access to the server personally or have some way to install MySQL on the server itself, can you have MySQL on the server.

If you just bought Web space from some provider, then all you can is to request the provider to install MySQL for you.

debsuvra

Make ISO files From Nero

I have Nero 7 essentials, which came with my DVD writer. I want to make image files with it, but can’t find any option to do so. So, I think Nero doesn’t have the facility to make ISO files, and if some of are aware of a way, then please tell me how to do it.

khansaqib101

Nero 7 Essential will allow you to save the image as an ISO file. All you need to do is save it as an image. Check this box, everything else is the same.

Slugger

Where’s FrontPage 2003
Q I have installed Office 2003, but can’t get to start FrontPage. In fact the shortcut is missing from the Start menu itself. I thought it is automatically installed with Office package (I did a complete installation). Do I have to install it separately? I searched my drives, but didn’t find anything at all.

karnivore

A FrontPage 2003 is not included in the Office 2003 Package and is available separately.

debuvra

Virtual Printer
I need a virtual printer software, which converts my HTML files to PDF, text, GIF and Word and vice versa. Thanks in advance.

Ismart

A novaPDF, only converts to PDF format

pushkaraj

A doPDF is a good start.

koolbluez

A I’ve been using cutePDF and it works fine.

Zeeshan Quireshi

Software
Q I want to browse a particular Web site offline. I want to download the whole Web site and browse it offline later with full functionality. I mean, if I click on a link on the main page / subsequent pages, it should direct me to the link instead of saying it as error. Is there any software like that? I want to buy it. It should be simple, effective, and fast. It should not be too cumbersome. Waiting for a reply. Those who have used similar software and feel that it’s the best, kindly give me the name of that software.

mayneu
Blocking Flash Advertisements

Those of us using broadband Internet know the value of bandwidth. The flash animated advertisements download quickly due to faster connections, but at the same time consume from the allotted bandwidth. I am an XP user with IE7 and want to restrict these bulky flash files from playing.

Can anyone here, out of personal experience suggest me a good way to overcome this problem? The flash files have become “necessary evils”, as they are sometimes compulsorily required. Disabling ActiveX in the setting is not an option, as they block all flash files. Is it possible to selectively disable advertisements only?

Sridhar_Rao

Flashblock (http://flashblock.mozdev.org) on Firefox

kalpik

FTP Downloads Using Batch Files

How to schedule FTP downloads through batch file creation? I know there are third party software that help us do this automation, but I want to do it through BAT files, which I can schedule and have my purpose solved.

Parminder001

Why don’t you just use the schedule feature in FDM? It supports both—scheduling the start and stop of downloads.
Torrents Blocked?

**Q** I’m not able to download any torrents since the past two weeks. None of the clients Azureus, Bitcomet or uTorrent is working. I tried forwarding the ports. Whatever the number of seeds, speeds don’t exceed 2-5 KBps, while they used to stay around 29-31 KBps earlier. But there is no problem in http or ftp downloads.

I have a 256 kbps Cable DSL connection from Ortel Communications, here in Bhubaneswar. My friends who have the same ISP are also facing the same problem, while BSNL guys are having full fledged downloads. I think, my ISP has blocked torrents. Is it possible? Please help.

**Lucky_star**

Try encryption in utorrent and see if that helps.

**varunprabhakar**

Your ISP is blocking all ports now. Call them up and ask them to open some port for you.

**QwertyManiac**

**Opera Icon**

**Q** My computer doesn’t show Opera’s icon for HTM and HTML files, although it does show Firefox’s icon if that is made the default program. Correcting it from Folder Options > File Types doesn’t help either. What is the problem?
**Cool Buddy**

Same thing happens with me with Flock. Delete the existing HTM and HTML extensions in file types. Then add same extensions HTM and HTML, and now associate the new file type with Opera.

**asnvin**

**Maximum Capacity**

I have a Kingston Data traveller 100. It’s a 4 GB pen drive, but only show 3.73 GB. So, I’m missing a good 200 MB! How can I gain that? I tried converting it into FAT system, but I couldn’t.

**chichi**

FAT16 or simply FAT doesn’t support partitions over 2 GB, so you can’t use FAT for your pen drive. You’ll have to use FAT32.

\[
4 \text{ GB} = 4,00,00,00,000 \text{ bytes}. \quad 4,00,00,00,000 \text{ bytes (divide by 1024)} = 39,06,250 \text{ KB} = 3814.7 \text{ MB} = 3.73 \text{ GB}. \quad \text{So this is the maximum you can use.}
\]

**gagandeep**

**Converting MKV files to AVI format**

I’ve downloaded some video files using Azureus Java Bittorrent client. Almost all the files available there are in MKV format. I can’t play them in my DIVX capable DVD player. Are there any freeware available to convert MKV to DIVX? Is there any other method to convert them?

**Writealexthomas**

Well I had the same issues some time back. ConvertXtoDVD (www.vso-software.fr/products/convert_x_to_dvd/) solved them all. The best part of it is that it also compresses the 4.4 GB MKV file to 2.1 GB with all the chapters and stuff (complete DVD layout). It is amazing, and also burns the movie in a DVD in the end.

MKV file was using AC3 codec and H264, so it was not that easy for a DVD player to read that format straight away. Hence, convert X2DVD was the thing, which worked out for me.

**akshaykapoor_3**

**Bad Video**
This is my configuration:
P3 @ 700 MHz, 256 MB SDRAM, Intel 810 chipset with onboard graphics.

I’m unable to playback XVID and DIVX videos with resolutions more than 720x576, videos higher than this resolution keep getting stuck, and the video totally lags with the audio. I use XP and Gomplayer and have even tried Media Player Classic, but to no avail.

I face more problems when playing H264 videos (can’t play even 480i videos). What can I do to get smooth playback.

Rahul

On my PC, it plays XVID DIVX @ 480 just fine. However, it cannot play H264 files smoothly, if the resolution is a little higher. WMV files @ 480 runs like slow motion.

Hackattack

H.264 processor requires a pretty high end processor, and a decent amount of RAM to run. A complete upgrade for your system is long overdue. H.264 is used in HD resolutions.

Playlist Transfer

I’m planning to reinstall my OS and happen to use Media monkey to play my music. I was just wondering if I could save my current playlists and then import it into the media player once I reinstall it. I don’t like the idea of selecting songs and making the playlists again. Please help. Thanks in advance.

jambay19

Copy contents of \My Music\MediaMonkey\ folder before reinstallation of OS and put it back after reinstallation

asnvin

Upload Flash
How to upload flash file on a Web site? For example, when we upload a file from many images uploader like imageshack, tinypic, etc., is there any way to upload a flash file also?

Boosters

You can upload it on YouTube and embed the URL? Isn’t that simpler?

legolas

Yahoo! Messenger Font Problem

I just installed Yahoo! Messenger 9.0 beta (Indian edition). Now when I run the programme, the screen shows rectangles instead of characters.

amit_stg

I think it’s because you may not have the required fonts. Control Panel > Regional and language settings > Advanced. Scroll down to 57002 and check All
Indian languages. You might need your Windows CD.

dheeraj_kumar

**SWF As Screensaver**

**Q** How can we set an SWF file (flash) as a screensaver in Windows XP Pro. Please give me the details for it.

**vagish**

**A** Use this: http://www.instantstorm.com/

Embed flash in an HTML file, and set the HTML as your background (make sure active desktop is enabled)

```html
<embed src="whatever.swf" width="800" height="600"></embed>
```

dheeraj_kumar
Here you’ll find problems that are so weird that they don’t qualify for any of the previous sections. The fact that we’ve received these questions, however, means that people out there are facing such problems. Solutions ahead
Broadband Connection Problem

The problem is that it connects occasionally even though it stays connected for a few minutes. Often, it does not connect at all. Sometimes from 10 AM to 3 PM it connects with good download speeds. However, if it’s a weekend then there is simply no chance of establishing a connection. I contacted many BSNL personnel, but ultimately didn’t get a good response from them.

It shows the following errors:
1. Error 678: The remote computer did not respond.
2. Error 619: Disconnected. A connection to the remote computer could not be established, so the part used for this connection was closed.
3. Error 718: The connection was terminated, because the remote computer did not respond.
4. Error 676: The phone line is busy.

Most often, I face “Error 676: The phone line is busy.”

Razesh Pediredla

The instability in the line and speed means that the problem could be with the phone line itself. If possible, check for disturbance in the line.

Files Problems
I use Windows XP Home original version in my PC. I tried to install Ubuntu Linux 7.10, but it destroyed the Windows XP (NTFS) partition because I tried the default setup. I connected to broadband using Ubuntu, and installed VLC player and some codecs to play media files. I lost my C: drive and the entire data of C:. Later, I recovered the lost partition and lost data. However, the problem is that most of the files (DOC, XLS, JPG and others) have not been opening. It is showing some junk characters. Some files are working well.

Badal Chandra Mondal
Data recovery never accurately recovers all the data. There is always going to be some corruption and that’s exactly what has happened to all the documents you had.

**Lease Line Bandwidth**

Q I am a subscriber of Digit, and have some queries for which I would like to get your valued feedback.

I have taken a leased line connection of 1 Mbps (1:1) using RF technology.

1. What is the download speed we should get on a standalone machine?
2. What is a fool-proof way of checking the bandwidth that we are getting?

Vipul Patel

A A 1 Mbps line should give you download speeds of around 125 KBps. The simplest way to check your download speed would be to download a substantially large file to your PC without a download manager. You should get close to 125 KBps. After that, also use a download manager and see the increase in speed. The speed does not only depend on your ISP, but also on the hosting used by the server you are downloading from and the state and traffic of the connection route.

**BSNL billing problem**

Q I have a question, is it possible for someone to use my BSNL broadband service from another computer (telephone), without me knowing? Because although I don’t use much for downloading the contents, but I do use it for skype while talking to one of my friend in Denmark. I still have been getting a large bill for the past two months. Besides, I didn’t use more than 1000 MB. However, on checking on the BSNL Web site, I was surprised to see a usage of 2509 MB. So, I thought if some other person is using it with my username and password. I would like to know what could be the problem. My telephone bill previously with using broadband (with Skype) was Rs 650-750 only. I use the Rs 250-per-month BSNL plan with 1 GB download free. Now since two months I’m getting a bill above Rs 3,400.

Vivek Mandre

A There are many reasons your download bills might be going up. Skype being a high quality voice chat software uses a fair bit of bandwidth. Download a bandwidth monitoring application such as
NetMeter (http://readerror.gmxhome.de/) and monitor how much bandwidth is being used constantly. You should be able to get a fair idea of how much bandwidth your applications are using.

One of the other possibilities could be a virus or a Trojan, which could be randomly sending and receiving data from the Internet. You should also change your password periodically to prevent anyone else from using your account.

**Canon Digital IXUS 970 IS vs. Canon Powershot SX100 IS**

Q I’m planning to buy a digital camera and am confused as to which to buy, Canon Digital IXUS 970 IS or Canon Powershot SX100 IS? By the way, what are the differences beyond zoom?

Pavan Kumar Gurrala

A The two cameras are aimed at completely different types of users. If you want something, you can stick into your pocket, then the Canon IXUS 970 IS is what you should get. The PowerShot SX100 IS is a bulkier, but has a larger optical zoom and is also much cheaper than the IXUS 970 IS. It is however, an 8 MP camera compared to the 10 MP 970IS.
Urgent

I am your regular reader and a longtime subscriber of Digit. Lately, I came to my hometown (UP) on vacation. Since the Internet connection at home is BSNL 750UL+, which runs at 256 Kbps, I tried using my own company’s account (Punjab), which is a Business 15000 account that runs at 8 Mbps. I entered the username and password for my company’s account, but it shows authentication failure.

Please note that Business 15000 is multi-user account, which I can connect easily in Punjab and it runs over multiple systems. I tried different settings in Router (Siemens SL141_121), but it just didn’t work.

I hope you guys will surely help me out of this. The slow speed is killing me. It’s my first technical help related e-mail to you.

Sayeed

It could possible that the multiple connections are only allowed from within a state or district. You should call up the ISP and ask for more clarity on this.

From the Forum—thinkdigit.com/forum

Actual Speeds

I am using a Tata Indicom broadband connection, which has 3 months validity at 256 Kbps at a cost of Rs 3,203. (About Rs 1,100 per month with no download limits at 256 Kbps). The actual download speed is about 30 KBps (As shown by download managers). It takes nearly 1 hour for a 100 MB file to download. Is this the normal speed? Then what does 256 Kbps mean?

Aanand

Basically, the speeds you should be getting are 256 Kilo bits per second (Kbps) / 8 = 32 Kilo Bytes per second (KBps). And you’re getting 30 KBps, which is quite normal.

Rayraven

Cell Phone Camera As Web Cam?

How can I use my N70-1 phone as a Web cam to my PC?

vamsikrishna919
http://www.motvik.com/download.php
Download the wwigo software for your mobile and enjoy.

rajhot

What’s Better, MP3 Or OGG Vorbis?
Q I don’t mind the file size or compatibility issue. Which has got a better audio quality?

sarincv

A For PC, it would be FLAC all the way, because it uses lossless compression, and is as good as, if not better than the proprietary codecs.

Anurag_panda

Low ping error!
Q I can’t play Call of Duty 4 online. So I tried some servers using Xfire to play. But when I start, I get the error, “Server is for low ping player only!” Please help me. I installed the latest update ver 1.5 for it. SP is working fine.

ajaybc

A Some servers have been set up to not allow users with a high ping. The server you might be connecting to maybe giving you really high pings, which is why you are being disconnected. Try connecting to servers closer to India, or ones that have no ping restriction.

Canon A560 Dying
Q I purchased a Canon A560 digital camera a few weeks back. I used the bundled “Panasonic Industrial Alkaline” batteries and took around 150 snaps with them!

After getting “Change the batteries” message, I promptly removed those batteries and replaced them with a new pair of “AA Alkaline” type Eveready batteries, but to my surprise, the batteries lasted only for 5 snaps! I thought it might be a problem with the batteries, so I again replaced them with a new pair of “NIPO” batteries, but it was the same story again...

They just lasted for 5-6 snaps and the camera switched off and I got the message “Change the batteries”... Is it the problem with the camera? or should I use more powerful NiMH or NiCD type of batteries?

jack_the_ripper
Yes, you need to get better batteries. Get some NiMH batteries with at least 2000-2500 mAh capacity and a charger. Won’t cost you much. Each battery would cost around Rs 80 or so. You can get it from camera shops or electronics shops.

**gulgulumaal**

**How To Check Download Limit?**

**Q** I have a BSNL Dataone 256 kbps (night free) plan. As the download is limited to 2.5 GB per month, is there any way to check how much I have downloaded out of 2.5 GB until now?

**PunjabiPRO**

**A** Visit [www.dataone.in](http://www.dataone.in).

If you are a Firefox user, then you can use datafox to check your usage. Visit Datafox at [http://thegoan.com/datafox/](http://thegoan.com/datafox/)
How To Make A Poster?

I have designed a poster for an exhibition at my college. Now I have to print it. It takes a lot of money to print large images as it can’t be printed in normal printer available at my college.

So I intend to split the image into small parts (A4 sized) print it and then join them to make the poster. That way we can print it in normal printers.

Now my problem is I need to know if there is any software to split it into several A4-sized parts? I searched for them online, but found that they were not designed for this purpose. Many of them are used for just dividing the image, such that it loads on Web pages faster.

Ajaybc

Block Posters (www.blockposters.com)

This free online tool will split the uploaded image and allow you to download PDF files of that.

blueshift
Connectivity Problems

Although my Compaq C754TU is connected to the Internet via a USB modem (Tata Indicom's Plug2surf), I cannot view any Web page in my browser(s), an error message is displayed “Server cannot be found. Check your connection and then try again”. And even if a few Web sites open up, they take ages to load. I know this isn’t a broadband, but it isn’t a dialup connection either. Is it due to a problem on the server? Cannot be, as people from customer care came and checked it, and found nothing was wrong with the signal. Is it due to wrong settings, but then how do I get connected. Nothing is wrong with the USB modem either.

GP P

Check your computer for any viruses or worms. Look at the speed at which the connection is uploading and downloading. Go to a different location and see if your connection speed improves. Also, try visiting some Indian sites and see if you do get better speeds.

LAN issue

I have an HP Pavilion Laptop (Model No dv1624tn). Everything works fine except LAN. Earlier it was working fine, but now from past few days, whenever I insert the LAN cable, it says limited connectivity. Else, it gets connected. However, I couldn’t surf the Net and it doesn’t open any Web page.
Whenever it says limited connectivity, I restarted the modem several times. It still has the same problem. I have seen that the green LAN LED always glows. The red LED, which is normally indicative of being busy, but it sometimes blinks or sometimes periodically like every after 3 seconds.

I have installed all the LAN drivers. In my laptop, the Intel Pro/100 VE Network LAN connection is there. I don't know how to check whether my LAN has gone or what? I have tried all the possibilities, but it doesn’t connect at all. I have a 2 Mbps connection. My WiFi works just great. However, LAN has the same problem.

Other than driver what would be the problem in my LAN? Can anyone please solve my problem? I will be very thankful to them.

Nkparsana

Call your ISP and ask them to check the connection.

aswin1

Go to IP v4 properties in network setting (LAN) and assign IP address as 192.168.1.2 and the netmask as 255.255.255.0. Reboot the modem and PC. Then go to ADSL modem properties by opening 192.168.1.1 (or whatever your router’s IP) on your browser and see if DHCP is enabled. This will help.

nish higher

150 feet, can I create a LAN?

My house and my friend’s house are 150 feet apart. We want to make a LAN. Is this possible with an RJ45 and CAT5? If yes, tell me what we need? If not possible, then tell me any other way to make it. If possible, tell me approximate expenses.

Tech. Masti

Nothing extra is needed. This is a small distance only. Just connect directly. Don’t forget to get the PC-to-PC Ethernet cable (cross-over cable if connecting PC-to-PC) or else get the normal cable if you are using a router to connect the PCs.

The network will be good when you have a router that becomes hassle-free. Else, you have to deal with small problems in directly connecting two PCs over LAN.

DigitalDude
Are you drowning in Tech Problems?

Specialist lifeguards are just a click away...
If you have a technology related problem, just log on to thinkdigit.com, visit our Tech Q&A section and let one of our experts solve it for you.
Troubleshooting has never been easier

www.thinkdigit.com

Presents

TECH Q&A